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Chapter 1: Remark Classic 

OMR Overview 

Software Overview 

Remark Classic OMR is a software package designed to collect data from marks (bubbles, checkboxes) on 

plain paper forms. The software works in conjunction with an OMR scanner to collect the data. The 

software then analyzes that data and/or allows you to export it to various file formats. 

The software is commonly used to grade tests and analyze various types of surveys. The following 

overview provides the basic steps to using the software. Click the links below to learn more about 

processing forms for your specific application. 

General Use: 

 Choose an OMR form to use. Standard forms are included in the software. Custom forms can 

be purchased from Scantron. 

 Create or locate a form template file. The form template tells Remark Classic OMR how to 

read your form. Form templates are created and/or Edited in the Remark Classic OMR 

Template Editor. Each form you wish to process requires a form template, but the form 

template is a one-time setup that tells the software how to read your particular form. Most 

standard forms already have a corresponding form template in the software. 

Note: Remark Classic OMR contains pre-defined form templates for many form 
types. The Template Editor is used when form templates need to be created for 
those form types that do not have pre-defined form templates (custom forms) or 
to make changes to existing form templates. 

 Process filled-in forms using an OMR scanner. Remark Classic OMR displays the data in a 

spreadsheet style grid based on the form template you used. Each row of this grid 

corresponds to one scanned form in its entirety and each column corresponds to one 

question or variable on the form. 

 Save data and/or use the built-in analysis tool, Remark Quick Stats®. Save the data to many 

output formats, including Access, Excel, SPSS, Oracle, SQL Server, ODBC, etc. Or, use the 

analysis program included with the software, Remark Quick Stats, to tabulate your survey or 

grade your test. If you use Remark Quick Stats, you can take advantage of powerful grade 

results, crosstabulations, graphs, charts and more. 

  

This user’s guide file is designed to provide information about all of the features of the software as well as 

guidelines for using the software. Software features are not only described, but you are also given steps 

for how to use the features. Items taken directly from the software, such as menus, buttons and dialogs, 

are in bold format whenever they are used in an instructional context. 

file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/remark_office_omr_overview_d/processing_forms_overview.htm
file://///cesium/corporate/Operations/Support/End%20User/Documentation/ROO/Drafts/ROO2014/remark_office_omr_overview_e/saving_data.htm


 

2 

 

You are encouraged to read the user's guide before using the software with your own forms. The Help file 

and the user's guide contain answers to many of the common questions and/or problems users 

potentially face. 

Optical Mark Reading Basic Concepts 

Traditional Optical Mark Reading (OMR) involves two major components: OMR scanners and OMR forms. 

OMR scanners are peripheral machines attached to your computer that are made to specifically read and 

interpret the marks on OMR forms. OMR forms are bubble sheets that are created to precise 

specifications so that they can be read by an OMR scanner. These forms are used for testing, surveying or 

anything else that requires the collection of information.  

OMR forms are set up in terms of rows and columns. There are two characteristics of an OMR form that 

allow the OMR scanner to recognize data: 

 Timing Marks- small, black marks that signify the vertical position of each row of data on the 

sheet. 

 Columns- the number of columns (channels) that are contained on the form. Each bubble on the 

form lines up with a particular column. OMR scanners can typically read either 12 or 48 columns, 

though there are other variations. See your OMR scanner’s documentation for the specifications 

for your model. 

OMR forms can optionally have other characteristics. Here are some other terms with which you should 

be familiar: 

 Sheets- the number of physical pieces of paper a form contains. For example, a double sided 

form on one piece of paper would contain one sheet with two sides. 

 Page ID Marks- pre-printed sequence of marks on an OMR form that when taken together 

produce a unique ID for the sheet.  

 Respondent Tracker (Lithocode)- a respondent ID that identifies a particular respondent’s form 

as it is being read by the OMR scanner. Respondent trackers can be represented by OMR bubbles 

or barcodes. 

The following example shows you how timing marks and columns work, followed by a sample OMR form. 
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This grid sample represents a fairly common 48-column form layout and allows you to count timing 

marks and columns on a form. Each region on a form lines up with a particular timing mark and a 

particular column (e.g., a region might start in row 10, represented by timing mark number 10, and 

column 12, represented by column 12). An OMR scanner uses the timing marks and columns on the 

form to locate regions containing OMR bubbles. 

The form on the following page is an example of an OMR form. You can see that the timing marks run 

down the left side of the form. There are 64 timing marks. This form also has 48 columns. Each row or 

column of bubbles lines up with a particular timing mark and a particular column number. 

The OMR scanner finds the OMR bubbles on the sheet using these timing marks and columns. When 

creating form templates in Remark Classic OMR, you also identify OMR bubbles to be processed 

using the timing marks and columns.  

 

 

 

Column 1 Column 48 
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Getting to Know Your Software 

The Remark Classic OMR software has three basic parts: 

 The Template Editor: You use the Template Editor to create template definitions for the forms you 

want to process. 

 The Data Center: You use the Data Center to read filled in forms, clean up the data and save the 

data. 

 Remark Quick Stats: You use Remark Quick Stats to analyze a survey or grade a test. 

Each part of the software has a similar layout with a main working window and a task pane to the left. The 

task pane shows you the possible things you can do based on where you are in the software. For example, 

if you just scanned filled in forms, the task pane gives you options to run Review Exceptions to clean your 

data and save options for saving your data. All of the functions in the task pane can also be found on the 

toolbar and in the main menus. You can also access Help from any screen via the HELP menu or by 

pressing F1. Remark Classic OMR supports basic Windows functions that you see in most desktop 

software, such as: 

 Cut, Copy, Paste from the Edit Menu (shortcut keys also supported) 

 Home and End Keys in the Data Grid 

 file|Save and file|Save As 

 file|Print 

 file --> Recent file Access 

 Edit|Find/Replace  

 Edit|Sort 

You can also customize the toolbar by right clicking on the toolbar and choosing Customize. There are 

several options that allow you to decide what toolbars you want to use as well as commands and shortcut 

keys. 

Technical Support  

Please use the following guidelines for seeking technical support for Remark Classic OMR. 

 

Outside the U.S. 

Contact your local sales agent for support. 

 

Within the U.S. 

NOTE: Services no longer under warranty or covered under a support agreement may 
be billable. 

When you have questions that are not answered by this manual or by the online Help system, call 

Scantron Software Support using the procedure below: 
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Procedure 

1. Record the sequence of steps leading to the problem.  

2. Record the text of all error messages encountered. 

3. Have your software Serial Number available; it is displayed in the About Remark Classic OMR 

window in the Help menu. 

4. Be available at the scanning system. 

5. Call Scantron Software Support at 1-800-445-3141. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

7 

 

Chapter 2: Software 

Installation and Activation 
Remark Classic OMR is installed on a Windows based computer. Once installed the software is activated. 

See the following sections for further details on installation and activation. If you need to uninstall the 

software, you may do so via the Windows Control Panel under Programs.  

System Requirements 

The following section provides the system requirements for running Remark Classic OMR.  

Minimum requirements: 

 Personal computer with 2 GHz or faster processor 

 Windows® 32-bit and 64-bit operating systems: Windows 7 SP1, Windows 8.1, Windows 10 

(Note: SP stands for "Service Pack")* 

 Note: If you are using ScanTools Prisma to control your scanner, you may only install 

Prisma on a 64-bit operating system. If you are using a 32-bit operating system, you will 

need to use ScanTools legacy (OMR/Image scanner option in the software) for scanning. 

 .NET 4.6.1 (or higher) framework 

 2 GB RAM 

 1 GB free fixed disk space 

 Screen/monitor resolution of 1024x768 or higher and at least 32-bit color 

 Supported OMR scanner 

 Mouse or other pointing device 

Recommended optional requirements: 

 Windows-supported printer 

 PDF Viewer required to view installed documentation 

 Microphone for speech recognition 

 Microsoft Outlook 2007 or greater can be used for email functionality; if not present an 

internal Remark Classic OMR email client (using your SMTP server) may be used 

 

*The software uses activation for license regulation. If you choose to install on a virtual machine (VM), due 

to the nature of how virtual environments behave, activation is required every time the software is run.  
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Installing the Software 

You must run the Remark Classic OMR installation program in order to use the software. Install Remark 

Classic OMR on a fixed drive with at least 1GB of free disk space. To scan into Remark Classic OMR, you 

must install the software on the same system to which the scanner is attached. Before installing the 

software, make sure you are an administrator on your computer. Each single license of the software can 

only be installed on a single computer. 

If you are upgrading to the latest version of Remark Classic OMR from an earlier version, do not install the 

software in the same directory as your previous version. Once the installation is complete, you can copy 

information from your old installation that you want to use in the new version (e.g. form templates, data, 

etc.). 

 Note: Form template files, RMK/RMX data files, answer keys (AKY) and survey definition files 

(SDF) are not backwards compatible. Remark Classic OMR converts these files from previous 

versions of the software automatically. However, once a file has been converted, it cannot be 

opened in a previous version of the software. Always make copies of these files before converting 

them. 

  

To install Remark Classic OMR  

If you downloaded the software: 

1. Double click the file you downloaded. 

2. Follow the on-screen instructions to display the Remark Classic OMR Installation window. 

 Note: The .NET 4.6.1 Framework is required to install Remark Classic OMR. If you do not have 

it installed on your system, you are prompted to install it. Once the .NET Framework 

installation completes, the Remark Classic OMR installation resumes normally. 

3. Follow the on-screen instructions to complete the installation. You are prompted for a serial 

number and authentication code. You can find this information in the email that you received 

when you purchased the software. 

4. Some operating systems may ask whether you wish to install the software for all users or only the 

person currently logged into the computer. In most cases, and especially if multiple people use 

this computer and need to use Remark Classic OMR on this computer, you should choose the 

option for "all users." 

5. When the installation completes, click the Finish button to close the installation program.  

  

Please retain the download in case you need to reinstall the software in the future. Once the installation 

completes, you may run the software. When you first run the software, folders are created in your 

Documents folder under Remark Classic OMR for you to store files for use within the software (using 

these folders is optional). 
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If you purchased the software on a CD-ROM: 

The Remark Classic OMR CD-ROM contains an auto play feature so that when it is inserted into your CD-

ROM drive, the installation begins automatically. This feature is only available if your CD-ROM drive's auto 

play feature is enabled. If the software installation does not automatically start, use the following 

instructions to install the software. 

  

1. Insert the installation CD-ROM into your CD-ROM drive. 

2. Select Start on the taskbar and then click Control Panel. 

 Note: Accessing the control panel may vary slightly based on the version of Windows you are 

running. 

3. Double click Programs (or Add or Remove Programs, depending on your operating system). 

4. Click Install and then follow the on-screen instructions to display the Remark Classic OMR 

Installation window. 

 Note: The .NET 4.6.1 Framework is required to install Remark Classic OMR. If you do not have 

it installed on your system, you are prompted to install it. Once the .NET Framework 

installation completes, the Remark Classic OMR installation resumes normally. 

5. Follow the on-screen instructions to complete the installation. You are prompted for a serial 

number and authentication code. You can find this information with the CD that came with your 

software. 

6. Some operating systems may ask whether you wish to install the software for all users or only the 

person currently logged into the computer. In most cases, and especially if multiple people use 

this computer and need to use Remark Classic OMR on this computer, you should choose the 

option for "all users." 

7. When the installation completes, click the Finish button to close the installation program.  

Once the installation completes, you may run the software. When you first run the software, folders are 

created in your Documents folder under Remark Classic OMR for you to store files for use within the 

software (using these folders is optional). 

Software Activation 

Remark Classic OMR requires activation in order to run on your computer. Activation means that the copy 

you have installed is licensed to the computer. Once the software is activated, it cannot be installed on 

another computer without deactivating it from the current computer. You may activate your software over 

the Internet (recommended) or through a manual (offline) method. 

The first time the software runs it attempts to activate. If you are connected to the Internet, the activation 

is seamless. It will connect to the server to ensure that the license is not already in use, and then activate 

automatically. There is nothing else you need to do. Note that the software also validates activation 

periodically. 
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Manual Activation 

If you do not have an Internet connection, you can activate the license manually. You are provided with a 

“token,” which is a file with a “.key” extension. You save that file and then take it to a computer with 

Internet connectivity. You upload the token, which activates your software. Then an activation key is 

returned to you to take back to the computer without Internet connectivity. 

We strongly suggest printing the manual activation steps so that you can easily follow them.  

Please use the following steps: 

6. When the Software Activation Required 

window appears, click the link for Want to 

activate manually? 

7. Under Step 1, click the blue “here” text to 

receive an activation token (file). Save the 

file on your computer or network. 

8. Take this token to a computer with Internet 

access.  

9. Log on to 

https://activations.gravic.com. 

10. Upload the token from Step 2.  

11. You receive an activation key in return. 

12. Go back to the computer with Remark 

installed and click the link for Do you have 

an activation key? 

13. Select the key from Step 6 and click OK. 

The software is now activated. Note that the 

software also validates activation periodically so you 

may need to repeat these steps if the computer 

running Remark is always offline (not connected to 

the Internet). In this case, you receive messages that you need to activate. There is a Software Activation 

link under the Help menu that you can access to perform the same steps above. 

Transferring a License 

The software license agreement states that any one copy of the software can only be installed on one 

computer. If you need to transfer your software to another computer, you may deactivate the license on 

one computer and then activate the software on the new computer. Transferring a license typically occurs 

when something happens to your computer and you acquire a new one, or when the person using 

Remark leaves and you need to assign the license to a new person. Note that once a license is deactivated 

on a computer, it cannot be activated on that computer again. You will need to contact Remark Support 

in this case.  

https://activations.gravic.com/
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To Transfer a License: 

1. Install the software on the new computer. 

2. Run Remark. You are prompted that a message 

indicating there are no activations available. Click 

the link for Want to transfer your license? 

3. A list of previous activated computer(s) is 

presented. You can choose to deactivate the 

license from a computer in the list and activate it 

on the current computer. This action is most likely if you reformatted your computer or received a 

new computer. If you do not recognize the 

computer(s) listed we recommend contacting 

your IT department to ensure that you deactivate 

the proper computer. Once a computer is 

deactivated, Remark will no longer run on that 

computer. 

 Note: Scantron Support cannot help 

you decipher the list of activated 

computers, as this is internal to your 

organization. If you are unsure what 

to deactivate, you must contact your internal IT help desk to assist you. 

4. Read the warning that states I understand that Remark Classic OMR will no longer run on my 

old computer and then mark the checkbox next to it to accept this statement. 

5. Click the Transfer button. 

The license is now transferred to the new computer. After a few seconds, Remark Classic OMR will run on 

your system. The software is now inoperable on the old computer and can be uninstalled (if available). 
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Chapter 3: Setting up Your 

OMR Scanner  

Overview 

This chapter provides general information about OMR scanners and how to configure your scanner in 

Remark Classic OMR. You should already have your scanner connected to your computer and, if 

necessary, the drivers installed that allow the scanner to work before attempting to use your scanner with 

Remark Classic OMR. Remark Classic OMR allows you to set up your scanner in one of three ways: OMR 

Only, OMR/Image Scanners or Prisma Scanner (the latter two capture scanned form images). 

OMR Scanners- General Information  

An OMR scanner is a peripheral device attached to a computer that is used to scan paper-based 

documents, such as standardized tests, evaluations and other form types. OMR scanners come in two 

basic types: hand feed and automatic feed. You feed sheets through a hand feed scanner one at a time. 

An automatic feed scanner can handle batches of sheets at one time. Some scanners connect to the 

computer with a serial cable and some connect using a USB cable (a driver is typically required for a USB 

connection). If your scanner uses a serial connection and your computer does not have a serial port, you 

may need to purchase an adapter. Please contact your scanner manufacturer for recommended adapters. 

Some OMR scanners also have imaging capabilities, meaning they can capture images of the forms as 

they are scanned. Having images is useful when reviewing scanned data. 

OMR Forms 

OMR forms are created specifically to be read by OMR scanners. For this reason, these forms are created 

to very precise specifications. It is important to Review these concepts here before you begin scanning 

forms. 

Aside from the bubbles on the form, the two major characteristics of an OMR form are the Timing Marks 

and the Columns. 
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Timing Marks 

Timing marks are small, black marks that signify the vertical position of each row of data on the sheet. 

These marks are placed along the edge of the form and indicate the presence of mark information to the 

OMR scanner. 

Columns 

Columns refer to the number of columns (sometimes called channels) that are contained on the form. 

OMR scanners can typically read either 12 or 48 columns, although 5, 14 and 40 are also possibilities. Each 

mark on the form lines up with a timing mark and a column. See your OMR scanner’s documentation for 

the specifications for your model.  

The following example shows the typical layout of timing marks and columns on a form. The timing marks 

go down the left side of the form and the columns are numbered from left to right. The actual bubbles for 

each field on the form could correspond with any combination of timing marks and columns (e.g., a 

region on the form may be present beginning with timing mark three and column five).  

 

Column 1          Column 48 

         

 

 

 

 

 

 

 

 

 

 

 

 

Selecting Your OMR Scanner 

Remark Classic OMR currently supports several OMR scanners. To use an OMR scanner with the Remark 

Classic OMR software, you must first select your OMR scanner from the list of supported OMR scanners. 

Please note that if your scanner requires a separate driver to operate, you must install that driver prior to 

using the scanner in Remark Classic OMR. Please see your scanner documentation for assistance with 

drivers and installation. 
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Selecting an OMR Only Scanner 

If your scanner is an OMR only scanner, meaning it does not have imaging capabilities, you should set it 

up using the OMR Scanner Properties window. 

 

To select your OMR scanner  

1. From the Remark Classic OMR Data Center, select the Tools menu and then click OMR 

Scanner.  

2. Click the Scanner Type down arrow to display a list of available scanner types. Choose the 

scanner you are currently using. 

Based upon your scanner selection, default settings are displayed. You may change the settings if it is 

appropriate to your system’s setup. The following table details the scanner options: 

 

Area Options Meaning 

 Scanner Type Shows the available OMR scanner models. 

Scanner Settings Recognition Threshold Sets how leniently or strictly the software 

interprets the marks. This setting specifies a 

value at which a mark is considered filled. 

 Mark Discrimination Sets the value that determines the difference 

between two marks that are filled or partially 

filled, as in the case of erasures. 

 Discrimination Cut-off Sets the value at or above which any mark is 

considered filled regardless of how other marks 

in the region are filled.   

 Erasure Threshold Sets the threshold to use when determining if 

an answer was erased. Lower thresholds are less 

discriminate (will pick up more erasures) and 

vice versa. This information is used for changed 

answer reporting in Remark Quick Stats. 

 Scanner Timeout Sets the number of seconds for the scanner to 

respond before timing out. 

 System Pause Sets the amount of time in milliseconds 

(1/1000th of a second) that the system pauses to 

ensure that all internal OMR scanner operations 

are complete. 

 Feeder option installed Mark this checkbox if your scanner has an 

automatic sheet feeder. 
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Area Options Meaning 

 Duplex option installed Mark this option if your scanner has duplex 

capabilities, meaning it can scan both sides of a 

sheet of paper in one pass through the scanner. 

 Select stacker installed Mark this option if your scanner has a select 

stacker installed (sometimes referred to a reject 

stacker or reject hopper). The select stacker is a 

separate tray where forms containing problems 

reside (e.g., if a form is scanned but cannot be 

recognized). 

 Transport printer installed Mark this option if your scanner has a printer. 

 Barcode option installed Mark this option of your scanner has a barcode 

reader. 

 SelfScore option installed Mark this option if your scanner can run in 

SelfScore mode (where grading is handled on 

the scanner using the scanner’s panel). 

COM Port Settings Port Number Use this setting to select the com port number 

on the computer to which the scanner is 

connected. If your scanner is connected via a 

USB converter, there will still be a com port 

listed. 

 Baud Rate Use this setting to set the default data transfer 

rate. This setting controls the speed of the 

transfer of data. 

 Data Bits Use this setting to set the default value for data 

bits, which are the smallest unit of information 

on the computer. Information is gathered by 

combining data bits into bytes of information. 

 Parity Use this setting to set the parity, which is an 

error detection method used to verify the 

integrity of individual characters in the data 

being transferred. 

 Stop Bits Use this setting to set the default value for stop 

bits, which are bits that indicate that a byte has 

just been transmitted. Every byte is preceded by 

a start bit and followed by a stop bit. 

 Flow Control Use this setting to set the default value for flow 

control, which is the process of adjusting the 

flow of data from one device to another to 

ensure that the receiving device can handle all 

of the incoming data. 
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 Note: Once you select your scanner model, the default settings are often 
appropriate. You may just need to tell the software which options your scanner has 
installed. 

3. Mark the appropriate options for your scanner. The settings you choose for the COM port must 

match the settings on the scanner exactly. 

Some scanners require you to manually 

configure or run configuration sheets through 

the scanner in order to establish settings. 

Please use your scanner’s user’s guide for 

configuration steps. Once the scanner is 

configured, use the same settings in Remark 

Classic OMR. 

4. Click the OK button to save your scanner 

setup options. 

 Note: Once you have selected your scanner, clicking the Defaults button sets the 
scanner’s properties back to original software installation state. 

You are now read to scan forms or if necessary, create a template in the Remark Classic OMR Template 

Editor. Go to Chapter 5 if you need to create a form template for your form. If you already have a form 

template for your form, you may go to Chapter 6 to learn how to scan filled in forms. 

 Tip: Many standard forms already have form templates in the software. Check the 
Templates folder of your Remark Classic OMR installation directory to see the form 
templates that ship with the software (the default path \MyDocuments\Remark 
Classic OMR 5\Templates). 

Selecting an Image Enabled Scanner 

If your scanner has imaging capabilities, meaning that it can capture images of the forms as they are 

scanned, you should set up your scanner in the OMR/Image Scanner Properties window. There is a second 

option called Prisma Scanner, which can also be used for imaging if your scanner supports it (see the next 

section).  

When using an image-enabled scanner, an image of each sheet is captured during scanning. You can 

archive these images and use them to view exceptions on forms that may need your attention (e.g. a 

multiple response where one was not permitted).  

 

To select your OMR/Image scanner  

1. From the Remark Classic OMR Data Center, select the Tools menu, click OMR/Image Scanner 

and then click OMR/Image Scanner Properties. 

2. Click the Auto Detect Scanner button to have the software automatically search for scanners on 

the system. Your scanner must be turned on, connected to the computer, and the driver must be 

installed (if necessary). 

 Note: You can choose your scanner in the Scanner Configuration area however, 
in most cases we recommend simply clicking the Auto Detect Scanner button. 

Based upon your scanner selection, default settings are displayed. Most items are turned on and off 

automatically based on how the scanner is configured. If an option is disabled, it means you cannot 
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turn it on or off manually. You have to adjust it on the scanner. Under normal scanning conditions, the 

default settings are appropriate. The following table details the scanner options: 

 

Area Options Meaning 

 Auto Detect Scanner  Searches all ports on the system for an active 

scanner. The scanner must be plugged in, turned 

on and connected to the computer and if 

necessary, the driver must be installed in order 

for the software to find it. 

COM Port Settings Baud Rate This setting determines the default data transfer 

rate. This setting controls the speed of the 

transfer of data. 

 Data Bits This setting determines the default value for data 

bits, which are the smallest unit of information on 

the computer. Information is gathered by 

combining data bits into bytes of information. 

 Parity This setting determines the parity, which is an 

error detection method used to verify the 

integrity of individual characters in the data 

being transferred. 

 Stop Bits This setting determines the default value for stop 

bits, which are bits that indicate that a byte has 

just been transmitted. Every byte is preceded by 

a start bit and followed by a stop bit. 

Scanner Options Use select stacker Mark this option if your scanner has a select 

stacker installed (sometimes referred to a reject 

stacker or reject hopper). The select stacker is a 

separate tray where forms containing problems 

reside (e.g., if a form is scanned but cannot be 

recognized). 

 Use transport printer  Mark this option if your scanner has a printer, 

which can be used to print score information or 

items such as date, time and record number as 

forms are scanned. 

 Use SelfScore This option is marked if your scanner is running 

in SelfScore mode (where grading is handled on 

the scanner using the scanner’s panel). Note that 

if the scanner is in SelfScore mode, this checkbox 

is checked and disabled. To turn off SelfScore, 

reset the scanner and then click the Find Scanner 

button. 
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Area Options Meaning 

 Use bar code reader Mark this option of your scanner has a bar code 

reader and you want to read bar codes. 

 Duplex scanner Mark this option if your scanner has duplex 

capabilities, meaning it can scan both sides of a 

sheet of paper in one pass through the scanner. 

 Write operations log Mark this option to create an operations log file 

for the batch. The file is located in the ScanTools 

Plus Data directory, in a file named 

OPERATE.LOG, and contains statistics on 

scanning operations. 

Recognition Settings Threshold Sets how leniently or strictly the software 

interprets the marks. This setting specifies a value 

at which a mark is considered filled. 

 Discrimination Sets the value that determines the difference 

between two marks that are filled or partially 

filled, as in the case of erasures. 

 Mark Cut-off Sets the value at or above which any mark is 

considered filled regardless of how other marks 

in the region are filled.   

 Erasure Threshold Sets the threshold to use when determining if an 

answer was erased. Lower thresholds are less 

discriminate (will pick up more erasures) and vice 

versa. This information is used for changed 

answer reporting in Remark Quick Stats. 

 Timeout Sets the number of seconds for the scanner to 

respond before timing out. 

 

3. Mark the appropriate options for your scanner. 

Most options are enabled and disabled based on 

how the scanner is configured. If an option is 

disabled, you may not change it in the software 

(you can typically change it on the scanner if it is a 

supported feature of your particular scanner). You 

can turn on and off certain features such as the 

printer and select stacker. 

4. Click the OK button to save your scanner setup 

options. 

 Note: Once you have selected your 
scanner, clicking the Auto Detect 
Scanner button sets the scanner’s properties back to the original state. 
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5. Select the Tools menu, click OMR/Image Scanner and then click Set as Default Scanner. 

Remark Classic OMR uses this scanner when any scanning commands are executed. 

You are now ready to scan forms. Proceed to Chapter 5 to learn how to scan filled in forms. 

Selecting a Prisma Enabled Image Scanner 

If your scanner is supported by ScanTools Prisma, you should set up your scanner as a Prisma Scanner. 

When using a Prisma image-enabled scanner, an image of each sheet is captured during scanning. You 

can archive these images and use them to view exceptions on forms that may need your attention (e.g. a 

multiple response where one was not permitted). Before attempting to select your scanner in Remark, 

ensure you have properly installed the scanner and any necessary drivers. 

 Note: Prisma is only available on 64-bit Windows operating systems. 

 

To select your Prisma scanner  

1. From the Remark Classic OMR Data Center, select the Tools menu, click Prisma Scanner and 

then click Set Prisma Scanner as Default. 

The scanner is automatically detected. If the scanner is installed on the computer correctly, there is 

nothing to configure in Remark Classic OMR. If desired, you can check/modify the recogntion settings by 

clicking Tools, then Prisma Scanner and then Primsa Recognition Settings. 

You are now ready to begin scanning forms. Proceed to Chapter 5 to learn how to scan filled in forms. 

 Note: Barcodes are not supported when using ScanTools Prisma. If you need to 
read barcodes on forms, use the OMR/Image Scanner option instead. 
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Chapter 4: Template Editor  

Template Editor Overview 

The Remark Classic OMR Template Editor is used to create form templates for the forms you process in 

Remark Classic OMR. You must create one form template file for each form that you process with the 

Remark software. The form template file defines all of the information needed for the software to process 

your form correctly. Once a form template is created, the form can be used as often as desired without 

needing to create a new form template (as long as the form does not change).  

Remark Classic OMR contains pre-defined form templates for many commonly available forms. If your 

form does not have an associated form template, you need to make a form template in order to use the 

form. If a form template already exists for your form, you do not need to use the Template Editor at all. 

You can skip to Chapter 5, Scanning Forms, and start scanning your forms. 

 Tip: Before attempting to use the Template Editor, check to see if your form already 
has a template created. By default, form templates are installed in this location: 
\MyDocuments\Remark Classic OMR\Templates. If you see folders that contain form 
templates you do not use, please do not delete the folders; this will force Remark 
Classic OMR to try to reinstall them when you next run the software. 

Form templates are created by looking at the physical form and then recreating the bubble areas in the 

Remark Classic OMR Template Editor. You use the mouse to drag boxes (called regions) around the marks 

(e.g., bubbles) and other areas you want to have recognized on your form. These regions tell the software 

where each piece of information you want to capture is located on the page and other pertinent 

information about the form. They also tell the software what type of data you need the software to output 

from each area.   

 Special Note for Image-Enabled Scanners: If you are using an image-enabled 
scanner, you must use templates that also have corresponding TIF images and 
ScanTools SDS files. The templates included with Remark Classic OMR have these 
associated files. If you need to make a template for a custom form, it is recommended 
that you contact Scantron for assistance to ensure you have the necessary files. 

 

Important Keyword: 

Region: A region is an Input, Barcode, or OMR area that you define. A single OMR region can contain one 

or more questions. 

The Remark Classic OMR Template Editor contains two basic components that you use to create and Edit 

your form templates. The left portion of the template Editor window contains a tree view (an item list) 

with nodes representing each region in your template. The right side of the window contains a visual 

representation of your form. You may use the tree view and the form representation area to work with 

your form template. Each region in the tree view contains the properties of that region, which are 

accessed by double clicking the region. You may think of a region as a question or item on your form. You 

may also double click within a region in the page representation area to view the region's properties. 

Once the form template is created, use the File menu to save it (it will have a .rco file extension). Form 

templates can be shared among Remark Classic OMR users if you process the same form types.  
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Creating New Templates 

Form templates are created in the Remark Classic OMR Template Editor. There are two main ways to 

access the Template Editor to create a new form template: 

1. From the Remark Classic OMR Data Center, select the file menu and then click New Form 

Template. Alternatively, with the Templates tab selected in the task pane, click New form 

template. 

2. From your Windows Start menu, click Start|Programs|Remark Classic OMR|Remark Classic 

OMR Template Editor. 

  

To create a new form template 

1. From the Remark Classic OMR Template Editor, select the file menu and then click New, to 

begin a new form template. The Properties window appears.  

2. Click the Next>> button to get started.  

3. In the Form Type section, choose Simplex Form or Duplex Form. A simplex form contains a 

single sided sheet or sheets and a duplex form contains a double sided sheet or sheets. Here are 

some examples of form types: 

 One sheet of paper with OMR marks on one side is a simplex form with one sheet. 

 One piece of paper with OMR marks on both sides is a duplex form with one sheet. 

 Two pieces of paper with OMR marks on both sides is a duplex form with two sheets (this 

is often in booklet form). 

5. In the Form Details section, choose the Number of Sheets and the Number of Columns in the 

form. The number of sheets corresponds with the how 

many pieces of paper the form contains (not the 

number of sides). For example, a one page duplex 

form would have one sheet with two sides. 

6. In the Form Description box, enter a brief description 

of the form, if desired. 

7. In the Form Manufacturer box, enter the name of the 

form manufacturer, if desired. 

8. If this form template will be used to scan in SelfScore 

mode (specially equipped scanners only), mark the 

checkbox titled SelfScore form template. 

9. Click the Next>> button to continue. 

The Step 2 window appears. 

10. If all of the sheets within the form have the same 

number of timing marks, mark the checkbox for Pages Contain the Same Number of Timing 

Marks and then enter the number of timing marks on the form. If each sheet has a different 

number of timing marks, deselect the checkbox and type in the number of timing marks on each 

side of each sheet. 
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11. If your form does not contain page ID marks or respondent trackers, click the Finish button and 

proceed to the next section. Otherwise, click the Next>> button to continue. 

The Step 3 window appears. This window allows you to specify page ID marks and/or respondent trackers 

(lithocodes) if either is present on your form. Page ID marks are used to identify a sheet within a form. A 

respondent tracker, often called a lithocode, is used to identify a particular respondent. A respondent 

tracker can be an OMR region or a barcode. In order to use respondent trackers, you must have a multi-

sheet form. You can use respondent trackers and page ID marks independently or together. If you use a 

page ID mark in conjunction with a respondent tracker, Remark Classic OMR can identify specific sheets as 

belonging to a specific respondent when reading forms. This feature is useful when scanning multi-page 

forms, such as booklets. If the pages are scanned out of order, the software is able to collate the data 

together based on the page IDs and respondent trackers. 

12. If identifying a page ID mark, mark the checkbox for Page ID Mark Present.  

13. Select whether the page ID mark is oriented by Column or Row. The specific information about 

the mark’s location changes depending on its orientation. 

14. Enter the information about the page ID mark’s 

location (e.g., location row or column, start row or 

column and end row or column). You will be able 

to specify specific locations in the next step. Use 

caution when entering the end column. If you 

instruct the software to read all the way to the 

end of the form, any stray marks in that area can 

be picked up, causing the page not to be 

recognized. It’s advisable to use an End Column 

that is one after your last page ID mark. 

15. If identifying a respondent tracker, mark the 

checkbox for Respondent tracker present. 

16. Mark the checkbox for Display Respondent 

tracker in grid if you would like the data from 

the respondent tracker to be visible in the data grid during form processing. 

17. Select the type of region being used for the respondent tracker in the box titled Recognition 

type. This region can be an OMR region or a barcode region. 

 Note: If using an OMR region as a respondent tracker, the OMR region must 
output a single piece of data. 

18. If the form you will be scanning has a read head test row (a sequence of marks that tests the read 

heads on the OMR scanner), mark the checkbox for Read head test in row and then enter the 

row number in the adjacent box. If your form does not have a read head test row, you may skip 

this step (it is not common). 

19. Click the Next>> button to continue. 
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The Step 4 window appears. This window allows you to select 

properties pertaining to the page ID marks. 

20. Select the column(s) that contain the page ID marks. 

21. If scanning a double sided form, mark the checkbox for 

Sheets have the same page ID values on both sides if 

the page ID marks are identical on both sides of the 

sheet. If the same page ID marks are not present on all 

sides of all sheets, deselect this checkbox and place 

checkmarks in the appropriate columns where the page 

IDs are located on each sheet. 

22. If you have chosen to use respondent trackers 

(lithocodes), click the Next>> button and go to step 22. 

Otherwise, click the Finish button to complete the 

Form Template Creation Wizard. 

23. If you are using respondent trackers, the Step 5 window appears. In the Template sheets 

containing respondent tracker regions area, select the location of the respondent trackers on 

the various sheets. Respondent trackers do not have to 

be present on each sheet. The default options for duplex 

forms are: All the odd numbered sheets or All the 

even numbered sheets and. The default option for 

simplex forms is All sheets. You may also enter custom 

locations by selecting the Custom option button. If 

using custom locations, enter them in the Respondent 

Tracker Present grid on a per sheet basis. 

24. Click the Properties tab to enter properties for the 

respondent trackers. This information tells the software 

where to locate the respondent tracker on the form.  

25. In the box titled Region Name, enter a name for the 

region. The default name is Respondent ID but you may 

enter a different name. 

26. In the Region Options section, choose a region type.  

 If the respondent tracker region is an OMR region, it must output a single piece of data. 

Therefore, you are limited to the Grid, Add and Binary region types.  

 If the respondent tracker is a barcode region, you can choose the Text or Numeric data type 

and enter the Measurement Options for the barcode. Barcodes must be vertical in 

orientation. 

27. If using an OMR region, select the orientation in the Orientation drop-down box. Orientation can 

be by Row or Column. 

28. In the Region Size section, enter the location of the respondent tracker region. Enter the 

following information: Start column, Number of columns, Column gap, Start row, Number of 

rows and Row gap. This information translates to the location of the region on the paper form. 

 Note: Specific properties of regions are described in greater detail later in this 
chapter. If you require more information about region types and region sizes, 
please refer to the next section. 
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29. Click the Finish button to complete creating your template.  

 

Remark Classic OMR opens a window with a tree view (item list) on the left and a visual representation of 

your form on the right. In this window you outline the areas to be recognized. 

Region Types Overview 

There are three types of regions you can create. A region is an area on the form for which you want 

Remark Classic OMR to recognize and output data.  

 

OMR (Optical Mark Recognition) Regions: 

OMR regions are used to capture marks, such as bubbles and checkboxes, on your form. Marks can be 

used to collect many varying types of information, ranging from multiple choice questions to ID numbers 

to names. 

How are they represented? 

Bubbles or checkboxes, often used for answering multiple choice questions, filling in names and codes, 

etc.  

Barcode Regions: 

Barcodes are used to encode just about any desired information, ranging from names to ID numbers to 

other demographic information. 

 Note: Barcode support is not currently supported if using OMR/Imaging as your scanner source. 

How are they represented? 

Vertically positioned on a form, often to capture demographic and descriptive information.  

Input Regions:  

Input regions allow you to manually enter information into your data set. For example, you can use Input 

regions to capture handwriting from comment areas and other open ended questions. The software does 

not automatically interpret handwriting, but it does allow you to hand enter the written information. 

How are they represented? 

An area for handwritten text, or other information that cannot be automatically converted to data. 
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OMR Regions 

An OMR region is an area on the form containing OMR bubbles, checkboxes, or some other complete 

shape. The respondent darkens the marks that correspond with his or her answer choice. Each OMR 

region contains a specific number of rows and columns. A single OMR region can contain one or more 

questions. When an OMR region is created, you must specify certain properties pertaining to the region, 

including the size of the region, the type of region and what output (data) Remark Classic OMR should 

generate.  

 

Types of OMR Regions 

There are seven types of OMR regions. The most commonly used regions are: 

 Multiple Region: A Multiple region designation is used for multiple-choice style questions. These 

questions can allow a single response or multiple responses. One Multiple region may contain 

more than one question, depending on how the marks are arranged on your form (e.g., a test 

answer sheet with rows of questions). 

 Grid Region: A Grid region designation is used for questions where the output from the rows and 

columns of bubbles represents one piece of data. The respondent typically fills in several bubbles 

that make up one response (e.g., student ID numbers, names, social security numbers).  

The less commonly used regions are: 

 List Region: List region designation is used for regions that contain multiple choice style 

questions, but the response bubbles are not contained in a single row or column. Each bubble has 

a unique output value. 

 Add Region: An Add region designates a region where the values of all of the chosen OMR 

bubbles are added together to produce one value. You can assign individual values to each 

answer choice (or mark on the form). 

 Boolean Region: A Boolean region designation is used when you want a user-defined value (e.g., 

Yes) to be output if an answer choice is selected and another user-defined value (e.g., No) for 

answer choices that are not selected. Each response is output to a separate cell in the data grid 

during form processing. In comparison, when you use the Multiple or List region types for 

questions that allow multiple responses, Remark Classic OMR places the data in a single cell, 

delimited by commas. The Boolean region type is useful for questions that allow multiple 

responses but for which you need the data in separate cells.  

 Binary Region: A Binary region designation is used when you want a pre-defined value (1) to be 

output if an answer choice is selected and another pre-defined value (0) for answer choices that 

are not selected. Binary regions output all responses to one cell.  
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OMR Region Orientation  

The region orientation property determines how the region is laid out: by column or by row. 

Column: Regions oriented by column contain questions that are positioned on the form in columns 

when the sheet is viewed in portrait position with the timing marks on the left. 

 

Example: 

 

Row: Regions oriented by row contain questions that are positioned on the form in rows 

when the sheet is viewed in portrait position. 

 

Example: 

 

Creating an OMR Region 

There are two ways to create any region type:  

Toolbar: Click the OMR toolbar button. This option creates a new OMR region after the item you 

currently have selected in the tree view (question list). 

Menu: Click the Region or Page menu (depending on your selection point) and then choose either OMR 

Region After or OMR Region Before, depending on where you want the region placed in the tree view 

(question list). 

Remember that the order in which the regions appear in the tree view is the order in which they are read 

during form processing. 

  

To Create an OMR Region 

1. Use one of the methods mentioned above to begin inserting an OMR region. If you insert from 

the menu you are immediately presented with the OMR Region Properties window. If you insert 

from the tree you first drag a box around the area on the form where the marks are present (if it 

is not drawn perfectly, you can make corrections in the properties window). 

The Properties window appears. Learn more about how to define an OMR region by continuing to the 

next section.  

 














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Defining an OMR Region's Properties 

Once you have inserted an OMR region, the Properties - OMR Region window appears. The following 

table contains a brief summary of the OMR region properties. 

  

Property Function 

Region name A name assigned to an OMR region. Region names are used as grid column headers in 

the data grid window and are exported when saving data to common file formats. 

Region names are limited to 60 characters. 

Type The type of OMR region being described. Region types include: 

Multiple- indicates a region containing multiple-choice questions. 

Grid- indicates a grid or matrix of marks (bubble, checkbox) that equates to a single 

piece of data (e.g., student ID number). 

List- indicates a region where each mark is assigned a unique output value, but the 

marks are not contained in a single row or column (e.g., a list of answer choices). 

Add- indicates a region where the values for each of the answers that are filled by the 

respondent are added together to produce a single value for numeric data, or 

concatenated together for textual data. 

Boolean- indicates a region where a user-defined value (e.g., Yes) is output for filled 

responses and another value (e.g., No) is output for non-filled responses. Boolean 

regions output one piece of data for each mark (answer choice) in the region. 

Binary- indicates a region where a value of 1 is output for filled responses and a value 

0 is output for non-filled responses. Binary regions output a string of responses (1s 

and 0s) to a single cell. 

Orientation Sets the orientation of the region in terms of columns and rows: 

Column- the region contains questions that are oriented in columns. 

Row- the region contains questions that are oriented in rows. 

Start column Sets the first column number in the region. Columns correspond to the column 

number on the paper form (1-48). 

Columns in region Sets the number of columns of marks contained in the region.  

Column gap Sets the distance between columns of bubbles in the region. If bubbles are right next 

to each other, this number is typically 1. If there is a one bubble gap between bubbles, 

the column gap is typically 2 (or -2 if working on the backside of the form). 
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Property Function 

Start row Sets the first row number in the region. Rows correspond to the timing marks on the 

left side of the form. For example, if the first bubble in the region corresponds with the 

fifth timing mark, the start row is 5. 

Rows in region Sets the number of rows of marks contained in the region. Remark Classic OMR 

attempts to determine the number of rows in the region for you but you should check 

this value. 

Row gap Sets the distance between rows of bubbles in the region. If bubbles are right above 

one another, this number is typically 1. If there is a timing mark gap between rows of 

bubbles, the row gap is typically 2 (or -2 if working on the backside of the form). 

Data type Sets whether the data should be considered text or numeric when saved/exported. 

Possible label scales Sets a range of pre-determined values as output Labels (e.g., A-E or 1-5). Use this 

setting to quickly enter labels into the Labels grid as opposed to entering each label 

individually. Each mark on your form is represented by a label. The label is the output 

when the filled in form is processed. Note that only label scales corresponding to the 

number of answer choices you have selected appear in this list. 

Labels Sets the output data that appears in the data grid when reading forms. Each mark on 

your form is represented by a Label. The Label is the output when the filled in form is 

processed. You cannot use the following reserved characters in the list of labels: 

commas, quotation marks, semicolons or parentheses. Enter labels carefully because 

once you have processed data, you cannot change your labels without reprocessing 

your forms. 

Values Use this setting to associate a numeric value with each textual answer choice (label). 

Values are used for calculating statistics for responses that are set to the textual data 

type. Values are also used when saving to the SPSS file format.  

Note: Values are not used as point values when grading tests. You cannot use them to 

assign partial crEdit to individual answer choices when performing test grading. If you 

need to assign partial crEdit, use Advanced Grade.) 

Possible value scales Sets a range of pre-determined numbers as Values. Use this setting to quickly enter 

Values for each of your textual output Labels into the Values grid as opposed to 

entering each Value individually. 

Scale Saves a scale of user-defined labels and values as output Labels that you can save and 

use over again (e.g., Excellent, Good, Fair, Poor). Click the Save Current Scale button 

after entering your labels in the Labels grid to save the scale for future use. 
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Property Function 

Define Format The Define Format feature applies to Grid OMR regions only. Mark this checkbox to 

enter a pattern for the data that is output during form processing. The default setting 

(*) indicates that the characters are displayed one after the other with no separators. 

The * is a placeholder for your data. You may change this pattern to enter items such 

as slashes for a date, decimal points, etc. Enter the appropriate character in the proper 

position (e.g., for a date: **/**/****). 

 

5. In the Properties window, enter the appropriate properties for the region, as 

described above. There are additional advanced features that may be defined. 

6. Click the OK button to create the region.   

After creating an OMR region, you can see the region in the page representation area 

and a new node is added to the tree view. Each OMR region in the page representation 

area is shaded in gray or yellow to differentiate the regions. A selected region is outlined 

in red.  

Combining OMR Regions (Linking) 

Marks that are separated by text, lines or graphics cannot be selected in one region definition. When 

creating an OMR region in an area that contains items such as text or lines, you can only select the marks. 

The Add Linked Region function allows you to link these types of marks into one OMR region. OMR 

region types that can be linked include Multiple, Grid, List, Binary and Add. The following is an example of 

a question layout that would require a linked OMR region: 

  

What is your gender?  

O    Female    O    Male 

  

The marks (bubbles) are separated by the response text in between them, but are still logically considered 

one question. However, you cannot select the word "Female" within your OMR region. Therefore, you 

create a region around just the mark for Female and then link the mark for Male to the original region.  

 

To use the add linked region function 

1. Create an OMR region around the first region to be linked as if it were its own region (in the 

example above, you would select the bubble for "Female"). Enter all of the region details as 

previously described. For the region size, only enter what pertains to what you have defined so far 

(in the example, the region is only one row by one column at this point). 

2. After defining the first part of the region, select the Region menu and then click Add Linked 

Region. The mouse turns into a crosshair. 
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3. Drag a box around the second area to be defined (in the 

example, you would select the OMR bubble for Male). 

4. When you release the mouse button the Properties window 

appears. This window contains the same settings that were 

defined for the first part of the region that you selected. You 

need only define the Labels and Values (if desired) section of the 

window (unless the number of bubbles in each appended region 

varies, in which case you can adjust the number of columns or 

rows). 

5. Make any necessary changes to the region definition and then 

click the OK button. 

 

Regions that are defined with the Add Linked Region feature are automatically linked to the previous 

region. These regions are colored blue in the page representation window.  

 Tip: Only regions of the same OMR type, data type and orientation can be linked. 

However, the columns/rows of marks do not have to have the same number of answer 

choices in order to be linked. 

To make changes to a region that is already linked, first separate the regions by breaking the link, then 

make the changes and relink the regions. Many properties can only be accessed by first separating the 

linked regions. 

  

To break a linked region 

1. Use the tree view or page representation area to select one of the OMR boxes within the linked 

set you want to separate. 

2. Select the Region menu and then click Unlink. 

The regions are separated into individual OMR regions. If you need to make changes to the regions, Edit 

the regions and then relink them. 

  

To relink regions 

1. While holding down the Shift key, select each OMR region to be linked by either clicking its node 

in the tree view or clicking it in the page representation area. 

2. After all regions are highlighted, select the Region menu and then click Link. 
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Barcode Regions 

Remark Classic OMR can capture data from barcodes on your forms. In order to use barcodes, your OMR 

scanner must include a supported barcode reader. You must set the barcode guides on the barcode 

reader component of the OMR scanner so that they begin with the column containing the barcode. 

Remark Classic OMR then reads the barcodes that are in that column. Barcodes must be oriented 

vertically on the form. Consult your OMR scanner’s documentation for specific information about the 

barcode reader function on your OMR scanner and any limitations on how many barcodes you may place 

on one form. 

 Note: Most barcode readers allow for a certain number of barcodes per column. Check 
your OMR scanner’s specifications for this information.  

Barcodes are often placed on forms using stickers. Remark Classic OMR cannot determine how many 

barcode stickers are on a form and whether barcodes are missing. Therefore, if you are in this situation, it 

is advisable to create a barcode that reads “blank” and use it as a placeholder for the missing barcode. For 

example, suppose you are anticipating having five barcodes on your form. However, on some forms there 

are only four barcodes. Suppose the four barcodes are in positions 1, 2, 3 and 5 (the space allocated for 

the 4th barcode is not used). On the affected forms, put a barcode that reads “blank” in the space 

occupied by the 4th barcode. Otherwise, Remark Classic OMR will read the 5th barcode as the 4th barcode. 

By having the “blank” barcode, you can easily discern which barcode was missing. 

 Note: Barcode support is not currently supported if using Prisma as your scanner source. If using 

imaging, use the OMR/Image Scanner option. 

 

Property Function 

Region name A name assigned to a Barcode region. Region names are used as grid column headers in the 

data grid window and are exported when saving data to common file formats. Region names 

are limited to 60 characters. 

Barcode 

orientation 
Barcodes are always in vertical (top to bottom) orientation. 

Data type Sets whether the data should be considered textual or numeric when saved/exported. 

Measurement Sets the number of millimeters from the leading edge of the form to the leading edge of the 

barcode (used for Sekonic OMR scanners only). 

  

There are two ways to create any region type:  

Toolbar: Click the Barcode toolbar button. This option creates a new barcode region after the item you 

currently have selected in the tree view (question list). 
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Menu: Click the Region or Page menu (depending on your selection point) and then choose either 

Barcode Region After or Barcode Region before, depending on where you want the region placed in the 

tree view (question list). 

Remember that the order in which the regions appear in the tree view is the order in which they are read 

during form processing. 

 

To create a barcode region 

1. Use one of the methods above to insert a Barcode region.  

2. In the Properties window, enter the appropriate properties 

for the region on the Barcode region, as described above. 

There are additional more advanced features that may be 

defined. 

3. Click the OK button. 

After creating a Barcode region, a new node is added to the tree 

view. You do not see the region in the page representation area.  

Input Regions  

Input regions reserve space in the data grid for the manual insertion of text during or after scanning. Use 

Input regions to capture handwritten information (e.g., a person’s name). You can manually type the 

information contained in the Input region into the data grid.  

An Input region has the following basic properties: 

  

Property Function 

Property Function 

Region name A name assigned to an Input region. Region names are used as grid column 

headers in the data grid window and are exported when saving data to common file 

formats. Region names are limited to 60 characters. 

Default fill Sets a default entry to be used in the Input region. The information typed here is 

automatically output to the data grid when forms are processed.  

Auto increment  

 

When used in conjunction with Default Fill, Remark Classic OMR assigns the next 

value in the range you define to the Input region in sequential order. For example, 

you can enter the number 1 as the default fill and then mark the Auto increment fill 

value checkbox. Remark Classic OMR automatically places sequential numbers in 

the Input region during form processing.  
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Property Function 

Prompt me for the fill 

value at the start of the 

read session 

Use this setting to enter a custom value for the image region at the time of reading 

the filled in forms. This fill value may be something that describes the forms you are 

processing. For example, if you are processing conference session evaluations, you 

could type in the name of each session and it is added to each data record.  

 

There are two ways to create any region type:  

Toolbar: Click the Input toolbar button. This option creates a new Input region after the item you 

currently have selected in the tree view (question list). 

Menu: Click the Region or Page menu (depending on your selection point) and then choose either Input 

Region After or Input Region before, depending on where you want the region placed in the tree view 

(question list). 

 

To create an input region 

1. Use one of the methods above to insert an Input region.  

2. In the Properties window, enter the appropriate properties 

for the region, as described above. There are additional 

more advanced features that may be defined. 

3. Click the OK button. 

After creating an Input region, a new node is added to the tree 

view. You do not see the region in the page representation area.  

Advanced Template Options 

There are many advanced properties that can be set to Help you refine survey tabulation, test grading, 

form tracking and utilizing external databases for verification of information. Please read the following 

sections for more details.  

Advanced Region Properties - General 

Once you have defined the basics of a region, there are several additional options under Advanced, all of 

which are optional. You can set up these additional options when you create a region or go back into a 

region's properties at any time to make changes. To get to the advanced properties for any region, open 

the region's properties window and then click the Advanced button. 

The Advanced Region Properties - General window allows you to adjust the following items: 

Include Region in Read Operation 

Remark Classic OMR allows you to set whether to read a region that has been defined. Most of the time, 

you want to read each region you define, thus this property is on by default. However, there may be an 
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occasion where you wish to turn off recognition of a particular region for your application. You can 

deselect the Include region in read operation checkbox to exclude data from this region when 

processing forms. If this checkbox is not marked the region exists in the form template, but no data is 

captured during form processing. This checkbox is on by default. 

Required Item 

Remark Classic OMR allows you to make items required to be filled during scanning. If an item is marked 

as required in the form template and you are using the Review Exceptions feature, Remark Classic OMR 

flags any items that are left blank. If you are using Review Exceptions during scanning, the scanning stops 

so that you may Review the unrecognized item. If you are using Review Exceptions after scanning, Remark 

Classic OMR includes the unrecognized item during the Review operation.  

Question Text 

Question text may optionally be added to make reports more meaningful. 

When question text is present, it is used on the reports to identify the 

question. If no question text is entered, the region names are used on the 

reports.  

You may manually type question text into the question text grid or paste 

text from the Windows clipboard by using the keyboard shortcuts (Ctrl + V) 

or by double clicking a cell, then right clicking and choosing Paste from the 

menu. In order to paste information, you must first copy it from another 

location (e.g., a Word document). You may select multiple rows in the grid 

to paste multiple lines of question text. There is one grid row for each 

question you have included in the region.  

Question Names 

When defining an OMR region with multiple questions in the same region, you can specify individual 

question names for each question in the region. By using individual question names, it is easier to save 

data to existing databases and other file types that may already be set up with specific fields. If you want 

to enter individual names, deselect the checkbox for Use default region names. 

By default, Remark Classic OMR uses sequential region names for each question in the same region. 

Sequential region names consist of adding numbers sequentially onto the region name you provide in the 

Properties - window. For example, if you enter a region name of Question, Remark Classic OMR calls the 

individual question names within the region Question1, Question2, Question3, etc. 

In contrast, if you use the Question Names section of the Question Properties window to enter individual 

question names, you are able to customize the question name for each question within the region. 

Question names are limited to 60 characters each.  

 Tip: The following characters are not allowed in region/question names due to the problems 

they could cause when exporting data to certain formats:  

.  - Period 

! - Exclamation 

' - Singe quote 

[ - Left bracket  

] - Right bracket 

, - Comma 

" - Double quote     
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( - Left parenthesis 

) - Right parenthesis 

Advanced Region Properties - Analysis 

Once you have defined the basics of a region, there are several additional options under Advanced, all of 

which are optional. You can set up these additional options when you create a region or go back into a 

region's properties at any time to make changes. To get to the advanced properties for any region, open 

the region's properties window and then click the Advanced button. 

The Advanced Region Properties - Analysis window allows you to adjust the following items: 

Test Settings 

Choose whether or not to grade an item. By default, Multiple, Boolean and List regions have grading 

turned on by default. All other region types are off by default. In addition, if you are scoring multiple 

versions of the test you should have a region on the form that tells the software which version of the test 

is being scanned. You can mark the Designate as test version ID option to tell Remark Classic OMR to look 

at this region to determine each student's test version. You can then use the available multiple answer key 

scoring options in the Advanced Grade feature of the Data Center. 

Survey Settings 

Choose whether or not to include an item when running survey analysis in Remark Quick Stats. By default, 

Multiple, Boolean and List regions have tabulating turned on by default. All other region types are off by 

default.   

Testing Point System 

Questions can be designated as Objective or Subjective questions: 

An objective question is one where respondents choose one or 

more pre-defined answers on a form by darkening in a mark (e.g., 

bubble). These questions are typically multiple choice or true/false 

questions. You may select the number of points to award for 

correct, incorrect and blank responses. 

A subjective question is one that is open ended and must be 

graded by a teacher, such as an essay or short answer question. 

Remark Classic OMR cannot automatically read this type of 

question; however, you can include points from a subjective 

question when grading. First, place a region on the form where the 

teacher can enter the appropriate amount of points earned on the 

subjective portion of the test. This is typically an OMR region where 

the teacher bubbles in the points earned. Then designate the 

region as a subjective item in the form template. This region must 

be set to the numeric data type in order to use the region as a subjective region. When setting up your 

answer key, enter the maximum number of subjective points that can be earned. When grading, Remark 

Classic OMR displays the overall, objective and subjective scores. 

Extra crEdit is available using the All points awarded should be treated as extra credit checkbox. This 

feature allows you to use Quick Grade to grade the tests and still designate a question as extra crEdit. 

When this checkbox is selected, any points awarded for the question are added to the total score 

(therefore it may be possible to score greater than 100%). 
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Analysis Respondent ID 

You may also set a particular region as a Respondent ID region so that it can be used as an identifier on 

reports. This feature is useful when you are capturing items such as ID numbers or names. When set as a 

Respondent ID region, the resulting reports show the information captured in the region alongside of the 

results. For example, if you administer a test where the students enter their ID number, the grade report 

shows the ID number and then that student's grade. When exporting data to some gradebook packages, 

you may also be required to set a Respondent ID. 

Note: Respondent IDs are included as identifiers in the analysis, but they are not tabulated or graded. In 

order to set a region as a Respondent ID, make sure it is set to Do not grade this item and Do not 

tabulate this item. 

Advanced Region Properties – Blank/Multiple 

Exceptions 

Once you have defined the basics of a region, there are several additional options under Advanced, all of 

which are optional. You can set up these additional options when you create a region or go back into a 

region's properties at any time to make changes. To get to the advanced properties for any region, open 

the region's properties window and then click the Advanced button. 

The Advanced Region Properties - Blank/Multiple Exceptions window allows you to adjust the 

following items: 

Blank and Multiple Exception Handling 

When people fill out forms, inevitably they will mismark them by leaving questions blank, filling in too 

many responses or leaving stray marks or erasures that might be interpreted as filled bubbles. You can 

specify how Remark Classic OMR should handle blank, multiple and duplicate responses in OMR regions 

when processing forms and exporting data. The default settings are: 

 Blank responses: The word BLANK is inserted for items that are not answered. 

 Multiple responses: All responses are shown but flagged with green when more than one 

response is chosen and not permitted.  

Color coding is also applied to the data grid, making the exceptions easier to locate: yellow for blanks and 

green for mults. Also by default, only one answer response is allowed. You can replace these values on a 

region-by-region basis. You may choose one of the default options listed or type in a custom value. The 

default options include Asterisk (*), Nothing, Space Character and Tilde (~). In addition, the word VOID is 

available for blank responses. 

Additional Options for Blank Responses: For a blank response, you can choose how you want to flag 

the region. Sometimes there are intentional blank characters in grid regions, for example, that you 

wouldn't want flagged. Suppose you are capturing a name and allow 10 letters. If a person's name is only 

5 letters, you wouldn't want the region to appear as blank because they only used half of the allotted 

characters. 

Therefore, you have the following options available under Flag blanks: 

 Always: If any character in the region is left blank, or the entire question is left blank, regardless of 

the replacement characters being used, the region is considered blank. Replacement characters, if 

used, are still utilized, but the region contains the yellow BLANK exception color. 
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 Ignore Leading/Trailing: If a leading or trailing character in the region is left blank, it is ignored. 

This allows you to capture data smaller than the allotted 

region without it being considered blank. You will see 

whatever data is captured and the region will not contain a 

yellow BLANK exception color. This setting applies to Grid 

regions only. 

 Never: If any character within the region is blank, or the 

entire question is left blank, Remark Classic OMR ignores it. 

The region never appears with a yellow BLANK exception 

color in the data grid. 

 Ignore Leading: If a leading character in the region is left 

blank, it is ignored. This allows you to capture data smaller 

than the allotted region without it being considered blank. 

You will see whatever data is captured and the region will 

not contain a yellow BLANK exception color. This setting 

applies to Grid regions only.  

 Ignore Trailing: If a trailing character in the region is left 

blank, it is ignored. This allows you to capture data smaller 

than the allotted region without it being considered blank. You will see whatever data is captured 

and the region will not contain a yellow BLANK exception color. This setting applies to Grid 

regions only.  

 

Additional Options for Multiple Responses: By default, questions only allow one response. If you wish 

to allow more than one response, you can choose the number of allowed responses in the Limit the 

number of multiple responses to drop-down list. If you set a limit, anything marked above the limit forces 

the question to be considered a multiple response and is flagged as such in the data grid. There is also an 

option to choose Select most filled response, which tells Remark Classic OMR to determine the mark it 

thinks is the most filled when two or more responses are detected. Use caution when using this option, as 

you will never see a multiple response for your Review. 

Advanced Region Properties - Database Lookup 

Remark Classic OMR has a Database Lookup feature that can: 1) verify that recognized data from a region 

appear in an external database, and 2) lookup and replace recognized data with additional fields from an 

external database. To use this feature, you link a region in the form template to an external database. As 

each form is processed, Remark Classic OMR verifies that the recognized data appear in the selected 

database field. If the data are not present, Remark Classic OMR flags the question as a Database Lookup 

error for correction. Database Lookup can be used with OMR, Input and Barcode regions. 

This feature is useful for validating names, identification numbers, zip codes, etc. It is also useful for 

pulling information you have already collected out of a database and inserting it into your processed form 

data. When you set up a Database Lookup region, you tell the software what field to validate, and whether 

to replace the output with a field from the external database and/or append additional fields from the 

external database. 

For example, suppose you are grading tests and you have the students fill in their ID numbers on the 

forms being processed. You could verify the ID numbers in a database to ensure the right forms are being 



 

39 

 

scanned, and then specify another value that corresponds to the ID number (e.g., a name). If the ID 

number is found in the database, Remark Classic OMR automatically displays the corresponding value 

(student name in this case) for that ID number in the data. When you run your grade reports, they are 

produced with each student's name, yet you did not have to type in that information (or have students 

bubble it in on the form). 

 

To use database lookup 

1. Create a region. 

2. From the Properties window, click the Advanced button.  

3. Click the Database tab. 

4. Mark the checkbox for Use Database Lookup. 

5. In the Database Selection area, use the Type drop-down list to select the type of database to 

which you want to connect this region (e.g., Access, Excel, etc.). 

6. Click the Browse... button to locate and select the database file.  

7. Select a file and then click the Open button (or double click the file name). 

If using an ODBC connection, perform the Steps 7-9 (you need to obtain specific information from your 

database administrator to complete these steps). Otherwise, skip to Step 10. 

7. [OPTIONAL]: Select your database type from the DSN drop-down list. 

8. [OPTIONAL]: Select the appropriate checkbox to indicate whether your database is Directory or 

DSN based: Directory based or DSN based. 

9.  [OPTIONAL]: If your database utilizes password protection, use the Username and Password 

boxes to enter your login information. If the database is not 

password protected, you may skip this step. 

10. In the Lookup & Return section, click the Connect to 

Database button to link the database to the region. 

11. Use the Table drop-down list to select the table in the 

database containing the fields to which you are linking the 

region. 

12. Use the Lookup drop-down list to select a field in the 

connected database to which you want to link this region. 

When the forms are processed, the respondents' answers are 

verified against the values in this database field. If the answer 

is found in the database field, Remark Classic OMR outputs 

the Replace value. If the answer is not found in the database 

field, Remark Classic OMR flags it for Review. 

13. Use the Replace drop-down list to select a field in the 

connected database to return when the Lookup field is verified. If you only want to verify data and 

not replace it with anything else, use the same field in both the Lookup and Replace lists. If you 

want to look up the value and then replace it with a different database field's information, select 

the appropriate field in the Replace list. 
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If you would like to pull other data out of your database to include in your Remark data, continue with 

steps 14-17. This is a quick and easy way to get information out of the existing database and into your 

processed data without having to put on the physical form. Otherwise skip to step 18. 

14. [OPTIONAL]: If desired, select database fields from the Additional Return Fields list to insert 

additional information from the database into the data grid during form processing. You may 

look up a field once but return several database fields' worth of information. Fields are listed in 

the data grid in the order in which they appear in the Additional Return Fields list. 

15. [OPTIONAL]: If desired, use the Return Names column to specify region names for the Return 

fields. By default, the name is taken from the external database to which the region is connected. 

You may type a new name in the Return Names cell if desired. 

16. [OPTIONAL]: Use the drop-down arrow to select Yes in the Respondent ID box to include the 

Return field in the reports as a respondent identifier. If this setting is set to Yes, the data 

collected from this region is used on the appropriate reports to identify the respondent. 

17. Click the OK button to save the changes and return to the tree view.  

When you process your filled in forms, Remark Classic OMR looks up the captured data in the database 

and if found, returns your Replace and Additional Return Field data. If the captured data does not match 

what is in the connected database, Remark Classic OMR flags it for your Review. 

 Tip: If your database name or location changes once you have set up your database lookup, when 

you open the template in the Data Center for processing, you are prompted to restore the 

connection settings. Click here to learn more about this window.  

Advanced Region Properties – Tracking 

Respondent Trackers, or lithocodes, can be used during scanning to place all of one respondent’s data 

together in a single data record. You designate a unique OMR or barcode region in the form template as 

your respondent tracker. Then, along with page ID marks, Remark Classic OMR matches data from the 

sheets scanned to their appropriate data records. Respondent trackers can only be used on multi-sheet 

forms and must be used with page ID marks.  

Setting up a respondent tracker has two parts. The first part is to tell Remark Classic OMR that you are 

using a respondent tracker in the form template properties. This step is covered here. Once you hav e told 

the software you are using a respondent tracker, and entered information about the respondent tracker 

region’s properties, the region is created automatically for you. You have successfully set up a respondent 

tracker at this point. If you need to modify the respondent tracker, you may use the instructions below. 
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To modify a respondent tracker 

1. When setting up the form template, ensure you have entered the 

appropriate page IDs and respondent tracker information.  

2. The respondent tracker region is created automatically for you. If 

you need to make changes to the field, continue. Otherwise, you 

have set up the respondent tracker field.  

3. Open the properties for the Respondent tracker region. 

4. If you need to make any modifications to the region’s set up, do 

so in this window. 

5. From the Properties window, click the Advanced button. 

6. Click the Tracking tab. Use the Set as a respondent tracker 

(lithocode) region checkbox to turn on or off respondent 

tracking on this region. 

7. Click the OK button twice to return to the tree view. 

Editing Regions 

Regions can be modified after they have been created in order to change properties such as region 

names, data types, orientation, labels, etc. If you select the entire region, you have access to all of the 

properties that are valid for that region.  

 Note: Changing regions in a form template does not change data that have already been 

processed. To update data that have been read you need to process the forms again, or use the 

Find/Replace option to change the existing data to match the revised form template. Changing a 

form template can also invalidate Grade/Survey analysis files. If you have already created these 

files, it is recommended that you recreate them based on the current form template settings. 

  

To edit regions 

1. Double click within the boundaries of the region you want to Edit, or double click the item in the 

tree view, to display the Properties window. 

2. Make the desired changes and then click the OK button. 

3. Save the form template when finished Editing. 

Working with Regions 

Once regions are created, you can use basic Windows functions to make modifications, including: 

 Drag/drop 

 Cut, copy, paste 

 Delete 

There are various ways to access these basic functions, including the keyboard, menus and toolbar. You 

can use whichever way is comfortable for you. 
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Drag/Drop, Cut, Copy, Paste, Delete 

When you create templates, the tree view (question list) on the left defines the order in which the regions 

are read when the forms are processed. If you need to rearrange the order, simply drag the regions into 

the right order. Holding Shift while you drag places the item before the selected item. Alternatively, you 

can cut a region and paste it elsewhere. You can also utilize the Windows copy function to create similar 

regions. When you copy a region, you need to then drag it to its proper location on the page 

representation. You can double click the copied region to make any adjustments to the properties. If you 

want to remove a region entirely, click the Delete button on the keyboard. 
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Chapter 5: Scanning Forms  

Scanning Forms Overview 

The Remark Classic OMR Data Center is used to process your filled in forms. You can scan forms directly 

into the software with an OMR scanner. When you process forms, you use a grid that is similar to an Excel 

spreadsheet. It utilizes all the familiar functions, such as: 

 Cut, copy, paste 

 Delete data or delete entire grid row 

 Find and Replace 

 Spell Check 

 Sorting 

 Freezing columns or rows 

 Print 

 Save/Save As 

There are various ways to access these basic functions, including the keyboard, menus and toolbar. You 

can use whichever way is comfortable for you. 

The Read feature is used to process filled in forms. Any problem areas are flagged for you with colors and 

special words, such as BLANK. You can click a cell to change a response or use the Review Exceptions 

feature for more automated data clean up. Once the data is cleaned, you can save it to various formats, 

including Excel, Access, SPSS, Oracle, SQL Server and CSV. You can also use Remark Quick Stats to grade 

tests and analyze surveys. 

Scanning Forms with an OMR Scanner 

When scanning forms in the Remark Classic OMR Data Center, the software reads pages directly from an 

OMR scanner connected to the computer. Before attempting to read any pages from the scanner, turn on 

your scanner, ensure it is set up in Remark Classic OMR and open the form template that corresponds to 

your forms. (See Chapter 4 for information about setting up your scanner.) The procedure for scanning 

forms varies based on the scanner you are using. The steps are separated in this user’s guide based on 

whether you are using an OMR scanner (no imaging) or an OMR/Image or Prisma scanner (image-

enabled). 
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To read pages from the scanner 

1. In the Remark Classic OMR Data Center, open the correct form template. 

2. Select the Tools menu and then click Read. Alternatively, you may select the Read link from the 

task pane or Read toolbar button. 

3. The first time you read forms you should click the Next button to configure how scanning takes 

place. You can optionally skip this step on subsequent scans. 

4. In the Welcome window, your scanner is listed. Beneath the scanner are the options you have 

indicated are installed on your scanner in the Scanner Properties window. The following options 

may be available to you depending on your scanner’s capabilities: 

 

Option Description 

Duplex scanning  You may use this option if your OMR scanner has duplex capabilities, meaning 

it scans both sides of the sheet in one pass through the scanner. If scanning a 

single sided (simplex) form, you do not need to turn off duplex scanning. 

Barcode  You may use this option if your OMR scanner has a barcode reader. 

Select stacker  You may use this option if your scanner has a select stacker (rejecter). When 

forms cannot be read, they are sent to the select stacker to be reviewed, 

without collecting data from them. 

Printer  You may use this option if your OMR scanner has a printer. You can print 

certain items, such as score information and dates, on forms as they are 

scanned. 

Grading/Scoring  You may use this option if your OMR scanner has grading capabilities built 

into the scanner. Grade-enabled scanners often print student scores on the 

forms as the forms are scanned (see your scanner manufacturer’s 

documentation for information about scoring scanners). 

 

Items in green are available and enabled. 

Items in red are not enabled. If you would 

like to change any of these options, click the 

Scanner Properties button (remember to 

click OK in the Scanner Properties window 

to return to the Read window). (Note you 

may only enable items that are installed on 

your OMR scanner.)  

5. If your OMR scanner has a printer installed 

and you have indicated that you have a 

printer in the Scanner Properties window, 

you may optionally mark the checkbox for 

Print on forms.  
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 Use the drop-down list to choose an item to print or enter free form text. Click the Insert 

button. Note that scanners use print buffers and can print a limited amount of text. Therefore, 

choose your items carefully to ensure you do not select more text than can be printed with 

your OMR scanner. If there is too much 

text it is truncated during printing. 

 Certain OMR scanners can print on the last 

two inches of the form only. In the Print 

position box, specify where to print the 

information on each sheet by entering a 

value of 0-63 for the start position (the 

number varies from scanner to scanner). 

6. [Optional] If your OMR scanner has a select 

stacker (rejecter) and you have it enabled, you 

may click the Next button to configure the 

Reject Sheets. When the select stacker is 

enabled, forms that are not properly read are 

sent to the select stacker without any data being captured. You may Review the forms, correct any 

problems and rescan them if desired. The reject options are covered in detail here. 

 In the Reject Sheets window, specify whether to reject exception cases during the scanning 

process by marking the Enable Reject Exceptions checkbox.  

 In the Reject Exceptions Options area, mark the checkboxes for those cases that you wish to 

reject during scanning.  

7. If you would like to configure Review Exceptions options (whether to stop scanning when 

exceptions are found), click the Next button to continue. Otherwise click the Read button to 

begin scanning pages, ensuring the pages are in the scanner. 

 Note: If desired you can click the drop-down arrow on the Read button and choose Save to 

have your Read settings saved as an Automation file (.RCEZ). The Automation Control Center 

is used to automate form processing.  

8. [OPTIONAL] If you have an Input region on the 

form that is set to prompt for a fill value, when 

the read process begins, a window appears 

where you can type the desired value. 

9. Remark Classic OMR continues scanning pages 

until the scanner's sheetfeeder (ADF) is empty. 

10. After processing all of the pages, you are 

prompted to continue scanning. Click Yes to scan 

more pages or No to end the scanning process.   

Once you have run through the Read window's configuration settings, you may optionally use the Quick 

Scan button on the toolbar for future scans with this template and all of your template's Read settings are 

utilized. We recommend returning to the Read window for any new templates you use to scan. If the 

Quick Scan button is not enabled, you may not have a scanner set up in the software (Tools|Scanner 

Properties or OMR/Image Scanner Properties).  

 Tip: You can overwrite specific grid rows of data by highlighting the row(s) first and then initiating 

the read process.  
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Scanning Forms with an OMR/Image or 

Prisma Scanner 

Scanning forms is handled through the Remark Classic OMR Read window. When scanning forms in the 

Remark Classic OMR Data Center, the software reads pages directly from an OMR scanner connected to 

the computer. Before attempting to read any pages from the scanner, turn on your scanner, install the 

driver if necessary, ensure it is set up in Remark Classic OMR and open the form template that 

corresponds to your forms. (See Chapter 4 for information about setting up your scanner.)  

 Note: The forms you wish to process must correspond to the selected form template.  

The Read window uses the scanner you have selected as the default scanner. It is possible to have a 

scanner set up as both an OMR Scanner and an OMR/Image or Prisma Scanner. If this is the case, make 

sure you choose the one you want to use by default by clicking the Tools menu, selecting the desired 

scanner (OMR, OMR/Image or Prisma Scanner) and then clicking Set as Default Scanner. For image-

enabled scanners, you want to set the OMR/Image or Prisma scanner as the default and ensure you turn 

on Enable imaging in the Read window. If you are using the ScanTools Prisma option, click Tools, then 

Prisma Scanner, and then Set Prisma Scanner as Default. 

The Data Center places the recognized data in the open data grid. All data obtained from reading one 

form appear in a single grid row. Each column of the data grid corresponds to each variable (question) 

defined in the form template. 

 Note: If you have not yet set up a scanner in Remark Classic OMR, select the Tools 
menu, click OMR/Image Scanner and then click OMR/Image Scanner Properties. 
Choose your scanner and any options installed on the scanner that you wish to utilize. 
The OMR/Image Scanner Properties window is covered in detail in Chapter 4. For 
Prisma scanners, there are no scanner parameters to configure. You can optionally 
configure the recognition settings by clicking Tools, then Prisma Scanner, then 
Prisma Recognition Settings. 

 

To read pages from the scanner 

1. Open the correct form template. Templates are located by default in \MyDocuments\Remark 

Classic OMR\Templates\Scantron.  

2. Place the completed forms in the scanner. 

3. Select the Tools menu and then click Read. Alternatively, you may select the Read link from the 

task pane. 

4. In the Welcome window, your scanner is listed. Beneath the scanner are the options you have 

indicated are installed on your scanner in the Scanner Properties window. The following options 

may be available to you depending on your scanner’s capabilities: 

 

Option Description 

Duplex scanning  You may use this option if your scanner has duplex capabilities, meaning 

it scans both sides of the sheet in one pass through the scanner. If 

scanning a single sided (simplex) form, you do not need to turn off 

duplex scanning. 
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Option Description 

Barcode reader  You may use this option if your scanner has a barcode reader. 

Select stacker  You may use this option if your scanner has a select stacker (rejecter). 

When forms cannot be read, they are sent to the select stacker to be 

reviewed, without collecting data from them. 

Printer  You may use this option if your scanner has a printer. You can print 

certain items, such as score information and dates, on forms as they are 

scanned. 

Grading/Scoring  You may use this option if your scanner has grading capabilities built into 

the scanner. Grade-enabled scanners often print student scores on the 

forms as the forms are scanned (see your scanner manufacturer’s 

documentation for information about scoring scanners). 

 

Items in green are available and enabled. Items in red are not enabled. If you would like to change any of 

these options, click the Setup button (remember to click OK in the Scanner Properties window to return 

to the Read window). (Note you may only enable items that are installed on your OMR/Image or Prisma 

scanner.)  

5. If your scanner has a printer installed and you have indicated that you have a printer in the 

Scanner Properties window, you may optionally mark the checkbox for Print on forms. (Printer 

options are covered in more detail here.) If using a Prisma scanner, the software will automatically 

detect if printing is enabled.  

 Use the drop-down list to choose 

an item to print or enter free form 

text. Note that some scanners can 

print a limited amount of text. 

Therefore, all three drop-down lists 

may not be enabled in order to 

ensure you do not select more text 

than can be printed with your OMR 

scanner. 

 Certain OMR scanners can print on 

the last two inches of the form only. 

In the Print position box, specify 

where to print the information on 

each sheet by entering a value of 1-

63 for the start position (the 

number varies from scanner to scanner). 

6. To ensure you are capturing images of scanned sheets, make sure the Enable imaging checkbox 

is selected. 

7. Click the Next button to continue.  

8. The image archiving window allows you to specify options about the images that are 

automatically stored each time you scan forms.  
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 In the Begin image names with box, enter a file base name that the software can use to 

name the images stored for this form. The default base name is the form template name; 

however, you may use any name you like. We suggest using something that identifies to you 

that the images belong to a certain form. The images that are stored all begin with this base 

name and then have the page number (if scanning a multi-page form), date and time 

appended to them to keep track of the various images. You may optionally choose a region 

from the form template to use as the base name. The value that is collected from the form for 

the specified region is used as the base name for the corresponding stored image. For 

example, if scanning student tests you could use a Student ID region with option to name the 

resulting image files by student. If you 

leave the Begin image names with 

blank, your images only have the page 

number (if applicable), date and time as 

the name of each image. 

 In the Destination folder box, click the 

ellipsis (...) button to select a location in 

which to store the images for this form.  

 Note: Choose the image location 

carefully. The images should remain 

in this location once the data is 

saved using the RMX/RMK formats 

if you want to retain the link 

between the processed data and 

each image file. This link allows you to view the forms on screen as you click through the 

data grid, making it easy to correct exceptions in your data. Therefore, you should plan 

ahead on how you will store these images when the forms are processed. 

 Tip: If you are sharing files with other Remark users, you may wish to save the image files 

on a shared network drive that all users have access to in the same manner (e.g., through 

a mapped network drive). 

9. [OPTIONAL] If desired, click the Name Builder button to further customize the stored image 

names and locations. 

 In the Image base name area, you 

may choose to add a region from the 

processed data to the image base 

name. Choose the region from the 

drop-down list and then click the 

Insert Data Into Base Name button. If 

you already added a region in Step 8, 

the Name Builder allows you to add 

additional regions. For example, if 

processing tests, you could add a 

Student ID that is being collected from the form so that your processed images all have the 

Student ID number in them. 

 In the Destination folder area, you may choose to add a region from the processed data to 

the folder structure that holds the processed images. Choose the region from the drop-down 

list and then click the Append Data Onto Folder Path button. For example, if processing 
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tests, you could add a Test ID that is being collected from the form so that each student's 

form images are stored in a folder containing the Test ID. 

10. Click the OK button to return to the Read window. 

11. In the Save image as box, select an image type to use for storing images. The choices are: 

PCX/DCX, PDF, TIF or JPG. 

12. Choose the Color Depth for the images: Black/White, Grayscale or Color (Black/White creates 

the smallest file). 

13. When saving to the PDF or TIF formats, you can choose the compression level under 

Compression level: Uncompressed, Group 3, Group 3 2d, Group 4 and LZW. Group 4 creates the 

most compressed image (smallest file size that take up less space on your computer). 

14. Mark the checkbox for Save images in a subfolder based on the form template's name to 

have the Data Center automatically create a folder in which to store these images based on the 

template name. This is a handy way to store all images related to a specific form in one place. 

 Tip: We recommend using the Save images in a subfolder based on the form template's 

name feature for easier organization of image files. Use of this feature keeps all images 

associated with each form template in one folder for easy access. The unique date and time 

portion of the image names prevents images from being overwritten. 

15. Mark the checkbox for Save multi-page form templates as multi-page image files if you are 

scanning a multi-page form and would like all of the images for one complete form to be saved 

as one image file. Using this option creates fewer image files and is recommended.  

16. [Optional] If your scanner has a select stacker (rejecter) and you have it enabled, you may click the 

Next button to configure the Reject Exceptions. When the select stacker is enabled, forms that 

are not properly read are sent to the select stacker without any data being captured. You may 

Review the forms, correct any problems and rescan them if desired. The reject options are 

covered in detail here. 

 In the Reject Exceptions window, specify whether to reject exception cases during the 

scanning process by marking the Enable Reject Exceptions checkbox.  

 In the Reject Exceptions Options area, mark the checkboxes for those cases that you wish to 

reject during scanning, as indicated in the table above.  

17. If you would like to configure Review Exceptions options (whether to stop scanning when 

exceptions are found), click the Next button to continue. Otherwise click the Read button to 

begin scanning pages, ensuring the pages are in the scanner. 

 Note: If desired you can click the drop-down arrow on the Read button and choose Save to 

have your Read settings saved as an Automation file (.rcez). The Automation Control Center is 

used to automate form processing.  

18. [OPTIONAL] If you have an Input region on the 

form that is set to prompt for a fill value, when the 

read process begins, a window appears where you 

can type the desired value. 

19. Remark Classic OMR continues scanning pages 

until the scanner's sheetfeeder (ADF) is empty. 

20. After processing all of the pages, you are 

prompted to continue scanning. Click Resume 

Scan to scan more pages or End Scan to end the scanning process.  
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Remark Classic OMR provides an Image Viewer at the bottom of the screen so that when clicking in a data 

cell, you can see the corresponding form image. If you cannot see the Image Viewer, click View|Image 

Viewer (you must have a valid OMR/Image or Prisma Scanner selected as your default to see this option). 

You can use the Image Viewer to Review data with Review Exceptions. 

Scanning Multiple Sheet Forms with 

Page ID Marks 

If you have page ID marks on a form, Remark Classic OMR uses the page ID marks to know whether the 

correct sheet of the form is being processed. If the sheets are out of order, they are flagged with an error 

message. The page ID marks act as a sheet identifier. When you create a form template with page ID 

marks, you specify the location of the marks on the form so that Remark Classic OMR can identify the 

various sheets of each form that is scanned. In order to recognize different sheets within one form, the 

sheets must have different page ID marks. If the page ID marks are identical from sheet to sheet, Remark 

Classic OMR is able to tell if you are scanning the correct form, but it is not able to differentiate sheets 

within that form. In addition, you must keep all of the sheets belonging to one respondent together, 

unless you are also using respondent trackers. 

 

To read multiple sheet forms with form ID marks 

1. Open the correct form template in the Remark Classic OMR Data Center.  

2. Place the completed forms in the scanner. 

3. Select the Tools menu and then click Read. Alternatively, you may select the Read link from the 

task pane. 

4. In the Welcome window, your scanner is listed. Beneath the scanner are the options you have 

indicated are installed on your scanner in the Scanner Properties window. If you would like to 

change any of these options, click the Scanner Properties button. 

5. [Optional] If your OMR scanner has a printer installed and you have indicated that you have a 

printer in the Scanner Properties window, you may optionally mark the checkbox for Print on 

forms. (Printing options are covered in more 

detail here.) 

6. [Optional] If your OMR scanner has a select 

stacker (rejecter) and you have it enabled, you 

may click the Next button to configure the Reject 

Exceptions. Otherwise click the Read button to 

begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent 

to the select stacker without any data being 

captured. You may Review the forms, correct any 

problems and rescan them if desired. Detailed 

information select stackers is found here. 

7. [Optional] If you would like to configure Review Exceptions options, click the Next button to 

continue. Otherwise click the Read button to begin scanning pages. Review Exceptions is a way to 
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correct exception cases found on forms, such as blank and multiple responses. (Review Exceptions 

is covered in more detail here.)  

 Note: Review Exceptions can also be run after all the forms are scanned if you prefer 
not to stop scanning when problems occur. 

8. Click the Read button to begin scanning pages. 

Remark Classic OMR reads forms until it cannot interpret the page ID mark or until all pages in the 

scanner are scanned. The software alerts you to an incorrect sheet, at which time you have several 

options, depending on how you are set up. If using a select stacker and rejecting misordered pages and 

form read errors, any sheets that are scanned out of order are simply be sent to the select stacker. Upon 

scanning completion, you can View a log of showing why sheets were rejected. If you are not using a 

select stacker, you receive a message that the sheet cannot be identified and when you click the OK 

button, you can decide whether to continue scanning. In either case, you can remove the sheet and 

replace it with the correct sheet and then click Yes. Or, you can remove the sheet and then move onto the 

next sheet by simply clicking Yes. To stop scanning all together, select No. To View the reject log, click 

View Log…. (The reject log can also be accessed any time by clicking Tools|View Reject Log). 

Reading Multiple Sheet Forms with 

Respondent Trackers  

Page ID marks alone act as sheet identifiers, but with the addition of respondent trackers (lithocodes), you 

can also keep respondents’ data together. A respondent tracker acts as a respondent ID and must be used 

in conjunction with page ID marks, which act as sheet identifiers, as explained in the previous section. If 

you have respondent trackers and page ID marks on your form, you can scan forms in any order and 

Remark Classic OMR is able to match sheets using the page ID marks and respondents to the appropriate 

record using the respondent trackers. Respondent trackers can be OMR or barcode regions. Setting up 

respondent trackers in your form template is covered here.  

 

1. Open the correct form template in the Remark Classic OMR Data Center.  

2. Place the completed forms in the scanner. 

3. Select the Tools menu and then click Read. Alternatively, you may select the Read link from the 

task pane. 

4. In the Welcome window, your scanner is listed. Beneath the scanner are the options you have 

indicated are installed on your scanner in the Scanner Properties window. If you would like to 

change any of these options, click the Scanner Properties button. 

5. Click the Next button to continue. 
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6. [Optional] If your OMR scanner has a printer installed and you have indicated that you have a 

printer in the Scanner Properties window, you may optionally mark the checkbox for Print on 

forms. (Printing options are covered in more 

detail here.) 

7. [Optional] If your OMR scanner has a select 

stacker (rejecter) and you have it enabled, you 

may click the Next button to configure the Reject 

Exceptions. Otherwise click the Read button to 

begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent 

to the select stacker without any data being 

captured. You may Review the forms, correct any 

problems and rescan them if desired. (Please click 

here for detailed information about using a select 

stacker.) 

8. [Optional] If you would like to configure Review Exceptions options, click the Next button to 

continue. Otherwise click the Read button to begin scanning pages. Review Exceptions is a way to 

correct exception cases found on forms, such as blank and multiple responses. (Review Exceptions 

is covered in more detail here.) 

 Note: Review Exceptions can also be run after all the forms are scanned if you prefer 
not to stop scanning when problems occur. 

9. Place the completed forms in the scanner. 

10. Click the Read button to begin scanning pages. 

Remark Classic OMR scans the forms and matches the sheets and records together. The software uses the 

page ID mark to know what sheet number is being scanned and the respondent tracker to determine the 

record to which the scanned data belongs. If a duplicate page is scanned, a message appears letting you 

know that data for the page already exists. You may click Overwrite to overwrite the existing data record, 

Ignore to ignore the new page’s data (discarding it) and leave the original data intact, or End Read to 

stop scanning altogether. Note that if you overwrite, you may be prompted for each page within a single 

record. 
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Using an OMR Scanner’s Select Stacker 

Some OMR scanners have a select stacker (also called reject stacker or reject hopper) that is used to 

collect forms during scanning that contain errors. If your OMR scanner includes a supported select 

stacker, you must select it in the OMR Scanner Properties window in order to use it. If you are using 

Prisma, the select stacker is automatically detected if your scanner has one. The following items can be 

rejected during scanning:  

 

Option Description 

Multiple responses Sends sheets to the select stacker if multiple responses are marked but not 

allowed in the form template. 

Blank responses Sends sheets to the select stacker if items are left blank. 

Barcode errors Sends sheets to the select stacker if the barcode cannot be read. 

Read head errors Sends sheets to the select stacker if the read head test fails. A read head 

test is only performed if the read head test checkbox is turned on in the 

form template properties. 

Timing mark errors Sends sheets to the select stacker if the timing marks on the form cannot be 

read. This type of error could be the result of choosing the wrong form 

template file, entering the wrong amount of timing marks for the form in 

the form template’s properties or a skewed form. 

Form read errors Sends sheets to the select stacker if form errors occur. Examples of form 

read errors include when page IDs cannot be identified or when the timing 

marks cannot be properly read (and you are not already rejecting on them). 

Database lookup 

regions 

Sends sheets to the select stacker if the database lookup region cannot be 

recognized. 

Required items Sends sheets to the select stacker if an item marked as required has an error 

(e.g., is left blank or has multiple marks). 

Misordered pages Sends sheets to the select stacker if pages are read out of order and you are 

not using respondent trackers (which allow scanning of respondents’ pages 

out of order). This feature is useful if using page identifiers and you want to 

reject any pages that are scanned out of order. 

 

 

To select the reject stacker option 

1. Select the Tools menu and then click OMR Scanner if you are using an OMR Scanner, Tools and 

then OMR/Image Scanner if you are using an Image Scanner. 

 Note: If you are using an OMR/Image or Prisma scanner, the setting for enabling the select 

stacker may be turned on by default if your scanner has a select stacker. 

2. After selecting your OMR scanner, mark the checkbox for Select Stacker Installed. 

3. Click the OK button to save the changes.  
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Once you have selected the Select Stacker Installed option in the software, you may read forms and 

specify what types of errors you want to apply to the select stacker.   

4. Open the correct form template in the Remark Classic OMR Data Center.  

5. Place the completed forms in the scanner. 

6. Select the Tools menu and then click Read. Alternatively, you may select the Read link from the 

task pane. 

7. In the Welcome window, your scanner is listed. Beneath the scanner are the options you have 

indicated are installed on your scanner in the Scanner Properties window. If you would like to 

change any of these options, click the Scanner Properties button. 

8. [Optional] If your OMR scanner has a printer installed and you have indicated that you have a 

printer in the OMR Scanner Properties window, you may optionally mark the checkbox for Print 

on forms. (Printing options are covered in more detail here.) 

9. Click the Next button to continue. 

10. In the Reject Exceptions window, specify 

whether to reject exceptions by selecting or 

deselecting the Enable Reject Exceptions 

checkbox. Then choose the options that will 

trigger an exception: multiple responses, blank 

responses, barcode errors, read head 

exceptions, timing mark errors, form read 

errors, database verification errors, required 

item errors or misordered pages (applicable if 

using sheet identifiers and/or respondent 

trackers). 

11. [Optional] If you would like to configure Review Exceptions options, click the Next button to 

continue. Otherwise click the Read button to begin scanning pages. Review Exceptions is a way to 

correct exception cases found on forms, such as blank and multiple responses. (Review Exceptions 

is covered in more detail here.) 

 Note: Review Exceptions can also be run after all the forms are processed if you prefer 
not to stop processing when problems occur. 

12. Click the Read button to begin scanning pages. 

During scanning, any forms that contain the specified reject options are sent to the reject stacker. A 

log is kept of each form that is sent to the reject stacker, explaining why it was rejected. When you 

finish scanning forms, you have an option to View the log in the dialog that appears at the end of 

each scanning session. You may also select the View menu and then click Reject Log to view the log 

file. 
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Using an OMR Scanner’s Printer 

Some OMR scanners have a printer installed that allows you to print specific information on each form as 

it is scanned. The printer can be used to print items such as a form number, date, field on the form (e.g., 

an ID field), etc.  If you are using Prisma, the printer is automatically detected if your scanner has one. 

The following items can be printed on the forms: 

 

 Time Stamp  Sequence Number 

 Date Stamp  Record and Sheet Number 

 Time and Date Stamp  Any Region in the Template 

 Sheet Number  Customized Text  

 Record Number  Grade Information 

 

If your OMR scanner contains a supported printer, you must select it in the OMR Scanner properties 

window in order to use it. 

 

To select the printer option 

1. Select the Tools menu and then click OMR Scanner Properties if you are using an OMR Scanner, 

Tools and then OMR/Image Scanner if you are using an Image Scanner. 

 Note: If you are using an OMR/Image scanner or Prisma scanner the setting for enabling the 

printer may be turned on by default if your scanner has a printer.  

2. After selecting your OMR scanner, mark the checkbox for Printer option installed. 

3. Click the OK button to save the changes. 

Once you have selected Printer option installed in the software, you may select what to print when you 

begin reading forms. 

  

To select print options 

1. Open the correct form template in the Remark Classic OMR Data Center.  

2. Place the completed forms in the scanner. 

3. Select the Tools menu and then click Read. Alternatively, you may select the Read link from the 

task pane. 

4. In the Welcome window, you see your scanner listed. Beneath the scanner are the options you 

have indicated are installed on your scanner in the Scanner Properties window. If you would like 

to change any of these options, click the Scanner Properties button. 

5. If your OMR scanner has a printer installed and you have indicated that you have a printer in the 

OMR Scanner Properties window, you may optionally mark the checkbox for Print on forms. 

 For Scantron OMR scanners only: Scantron OMR scanners can print on the last two 
inches of the form only. In the Print position box, specify where to print the 
information on each sheet by entering a value of 0-63 for the start position.  
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6. Use the drop-down list to choose an item to print 

or enter free form text. Note that scanners use 

print buffers and can print a limited amount of 

text. Therefore, choose your items carefully to 

ensure you do not select more text than can be 

printed with your OMR scanner. If there is too 

much text it is truncated during printing. You 

may choose standard items such as date, record 

number, etc. Or you may choose grading items, 

such as Grade, Total Score or Percent Score. If 

you wish to print grade information, the first 

form you scan must be the answer key. 

7. [Optional] If your OMR scanner has a select 

stacker (rejecter) and you have it enabled, you may click the Next button to configure the Reject 

Exceptions. Otherwise click the Read button to begin scanning pages. When the select stacker is 

enabled, forms that are not properly read are sent to the select stacker without any data being 

captured. You may Review the forms, correct any problems and rescan them if desired. (Using a 

select stacker is covered in more detail here.) 

8. [Optional] If you would like to configure Review Exceptions options, click the Next button to 

continue. Otherwise click the Read button to begin scanning pages. Review Exceptions is a way to 

correct exception cases found on forms, such as blank and multiple. (Review Exceptions is covered 

in more detail here.) 

 Note: Review Exceptions can also be run after all the forms are scanned if you 
prefer not to stop scanning when problems occur. 

9. Click the Read button to begin scanning pages. 

As the forms are scanned, the item or items you selected to print are printed on the forms. 

Using Batch Headers 

The Remark Classic OMR Data Center includes a batch processing feature that allows you to process batch 

header forms along with your forms. Batch header forms provide further information about the group of 

forms being processed that make your data more meaningful. For example, if you are processing student 

tests or course evaluations, you can process a batch header form containing information such as 

instructor name, class name, class section, and so forth. The batch header form is processed once, at the 

beginning of each batch. Then the forms that correspond to that batch header form are processed 

subsequently. The data from the header form is pre-pended to (added to the beginning of) each data 

record. You can start processing a new batch and its corresponding forms at any time. The header data is 

also available when it comes time to report on the data in Remark Quick Stats. 

To create a batch, you create form templates for the batch header form(s) and the form you wish to 

process with that batch header form (called a primary form template). You can use multiple batch header 

forms but only a single primary form template. You then combine these form templates into a batch file. 

Both forms must have unique Page IDs on them. Remark Classic OMR uses the page IDs to understand 

when a batch header form is being read versus a regular form. Therefore page IDs are required, even for 

single page forms. 
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 Note: In order to use an OMR/Image or Prisma scanner with a batch header, you need the 

appropriate Remark (RCO), ScanTools (SDS/STX) and image files (TIF). Please contact Scantron for 

assistance with creating the file necessary to use batch headers. 

 

To use batch headers 

1. Create or locate a form template for the form you wish to process as a batch header form. Ensure 

the form has a Page ID. 

2. Create or locate a form template for the form 

you wish to process along with the batch 

header form. Ensure the form has a unique 

Page ID. 

3. In the Remark Classic OMR Data Center, 

select the file menu and then click Batch 

Creator.  

4. In the Batch Creator (Step 1) window, select 

the form template that is being used as the 

primary form template (not the header form). 

This is the form template that corresponds to 

the form you wish to process after each batch header form. Click the Add file(s) button to add 

the form template to the Primary Form Template box. 

5. Click the Next button to continue. 

6. In the Batch Creator (Step 2) window, select 

the form template corresponding to your 

batch header form. Click the Add file(s) button 

to add it to the Batch Header Form 

Templates box. You may select multiple batch 

header form templates if desired. 

7. Click the Next button to continue. 

8. In the Batch Creator (Step 3) window, enter a 

file name for the new combined batch file. The 

Data Center combines the form template and 

batch header form template(s) into one batch 

file. The new combined file has a .rbf file 

extension. 

9. Click the Create Batch button to combine the 

templates and exit the Batch Creator. When the 

batch file opens in the data grid, a dark line 

defines the end of the batch header form 

template regions from the beginning of the 

primary form regions. 
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10. Process the first batch header form (or forms) by starting the Read process. If you need 

information about how to use the Read window, click here. 

11. Follow the batch header form with the forms that correspond with the group identified on the 

batch header form. 

12. When the first group of forms has been processed, insert a new batch header form and follow it 

with the corresponding forms. 

13. Continue processing forms in this fashion until you have processed all of your batches. In the end, 

you see an entire data set with all of the batch header information pre-pended to the records. 

 Tip: If you have already created a batch file and want to open it without using the Batch 

Creator, select the file menu and then select Open Form Template. Change the files of type 

drop-down list to Remark Classic Batch files to view available batch files. Recently used 

batch header files are also included in the Recent list in the task pane.  

Respondent Detection 

Remark Classic OMR includes the ability to determine which respondents' forms have been processed, as 

well as locating duplicate respondents. This feature, called Respondent Detection, is used in conjunction 

with Database Lookup. If a region is linked to an external database using Database Lookup, the software 

provides a report of which respondents listed in the external database have been processed, not been 

processed or have been processed more than one time. For example, suppose you have a region on your 

form where the respondent fills in an ID number. You can link this ID number region to an external 

database that has all of the ID numbers of your expected group of respondents. You can then use 

Respondent Detection to compare IDs collected in the data set to IDs in the external database. Any time 

you use the Respondent Detection feature, you also have the option to return additional data from the 

external database if desired (this is not required to use Respondent Detection). When you process your 

forms, Remark Classic OMR confirms which ID numbers from the external database exist in the processed 

data. The software then provides a report showing found ID numbers, missing ID numbers and duplicate 

ID numbers. If you are returning additional fields, this information is also available in the report. You can 

save this report as a text file to use outside of Remark Classic OMR. 

 

To use Respondent Detection 

1. Setup a form template that uses the Database Lookup feature. 

2. Process forms using the scanner or by reading from image file using the Read window. If you 

need information about how to use the Read window, click here. 

3. Once the forms have been processed and the data cleaned, select the Tools menu and then click 

Respondent Detection.  

 Note: You can run Respondent Detection with multiple data sets open. The Data Sets 

window opens, allowing you to choose the open files you wish to include in the save 

operation. Mark the checkboxes of all data sets you wish to include in the operation. You may 

use Select All to select all data sets in the list. Please note that the data set must correspond 

to the active form template in order for it to be included. 
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4. Choose the template region identifying 

respondents from the Respondent region drop-

down list. 

5. If the region is linked to a database containing 

additional fields, you may optionally select those 

fields from the Database Field List. Use the 

arrow to move the desired fields into the 

Additional Fields box. Any fields moved to the 

Additional Fields box are also used for 

detecting respondents. 

6. Click the Search button to continue. The 

Detection Results window appears. 

7. Use the Detection Results window to view your 

results. The main region on which you are basing 

the detection is listed first. You then see a 

Detected column that marks the values that 

were detected. The Duplicates column is next, 

which marks any duplicate values that are found. 

After the Duplicates column, you see any 

additional return fields from the external 

database that you selected in Step 5 (if you 

selected any). 

8. If desired, use the Export button to save the 

results to an external file. You may click the 

Export button to export the entire set of results, 

or use the arrow on the Export button to select 

which portions of the results to export. The 

export options are as follows: 

9.  

Option Function 

Export Exports all results (region, detected, missing, duplicates and additional fields). 

Export 

Missing 

Exports only the missing respondents, those that exist in the external database but were 

not processed as part of the data file. 

Export 

Detected 

Exports only the detected respondents, those that both exist in the external database 

and were processed as part of the data file. 

Export 

Duplicates 

Exports only the duplicate respondents, those that appear more than once in the data 

file. The software only detects duplicate entries that have also been verified as existing in 

the linked database. 

Print Results Prints all results to the default printer on your computer. 
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9.  Click the Close button to return to the Remark Classic OMR Data Center.  

Reviewing Duplicate Responses 

Remark Classic OMR includes a feature to detect duplicate responses even when not using the Database 

Lookup feature with Respondent Detection. The Review Duplicates feature allows you to choose any 

region in the data grid in which to search for duplicates. When a duplicate entry is found, you are 

prompted to take one of four possible actions: Review the duplicates, keep only the first duplicate record, 

keep only the last duplicate record or delete all duplicate records. During the Review process, the data 

grid is automatically sorted on your duplicate identifier region so that you can easily Review the data. This 

feature is useful if you accidentally process a form multiple times, or someone fills out a form multiple 

times when this is not permitted. 

  

To use Review Duplicates 

1. Open a form template and process forms with the Read option. If you need information about 

how to use the Read feature, click here. 

2. Once the data is collected and cleaned, select the Tools menu and then click Review Duplicates, 

or select the Review Duplicates link in the task pane.  

3. In the Review Duplicates task pane on the left side of the window, use the Which column 

contains the respondent ID drop-down list to choose a region or image files from your data that 

you want to check for duplicate entries. If you have an image enabled scanner, using the Image 

Names option is useful if an entire set of forms was accidentally processed twice. If the same set 

of images exists more than one time (based on the image file names), the images are flagged as 

duplicates. 

4. Click the SEARCH button to begin the search for duplicate entries. Remark Classic OMR tells you 

how many duplicate records are found. 

5. Determine the action you wish to take: 

 Review: If you want to Review the duplicates before taking action, choose Review Duplicate 

Records and then click the REVIEW button. Remark Classic OMR highlights any sets of 

duplicate records it finds. The NEXT button takes you to the next duplicate record within the 

same group. The Go To Next Group drop-down arrow on the NEXT button takes you to the 

next group of duplicates (you may have more than one set of duplicates within the same 

region). Similarly, the PREVIOUS button takes you back to the previous duplicate record 

within the same group, and the Go To Previous Group drop-down arrow on the PREVIOUS 

button takes you back to the previous group of duplicate records. During the Review, you can 

click the DELETE RECORD button to delete the highlighted record. 

 Keep First Duplicate Record Only: If you select this option, the first record in every set of 

duplicate records found is kept and any duplicates are deleted. Click the PURGE button to 

take this action.  
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 Keep Last Duplicate Record Only: If 

you select this option, the last record in 

every set of duplicate records found is 

kept and any duplicates are deleted. 

Click the PURGE button to take this 

action. 

 Delete All Duplicate Records. If you 

select this option, all duplicate records 

are deleted. Click the DELETE button to 

take this action. 

6. If you choose any action that causes records 

to be deleted, you receive a warning message to ensure that you want to delete the records. Note 

that once the records are deleted, they cannot be recovered (unless you process the forms again). 

If you are sure you want to proceed, click the Yes button. The requested action is taken. 

7. If you wish to search for more duplicates in other regions, repeat step 5. 

8. When you are finished reviewing duplicates, click the FINISH button. 

9. Click the Back arrow underneath Review Duplicates to return to the full task pane. 

Database Connection Settings 

If you set up a database connection in the form template, you can adjust the settings from the Data 

Center by using the Database Connection Settings link in the task pane. This feature allows you to change 

the database connection, the lookup criteria and save the settings to the existing or a new form template. 

This feature is useful if the database filename or file location changes. It also is useful if you want to save a 

connection for different users; you can set up the connection once, and then modify it for each user. 

 

To use Database Connection Settings 

1. Open the desired form template. 

2. In the task pane, click Database Connection Settings. The Database Connection Tool window 

appears. 

3. This window is the same as the window for setting up the database connection in the template 

editor. You can change the Type, Lookup & Return Fields and Additional Return Fields. Make 

the desired adjustments. 

4. Choose whether to save the changes to the form template by clicking the Save changes to the 

form template file checkbox. 

5. If you would like to rerun the lookup with an open data set, click the Rerun lookup checkbox. 

When you close this window, Remark Classic OMR will cycle through your data and apply the new 

database connection to the open data set. 

6. [Optional] If you want to save the changes to a new form template (e.g. for a different user) click 

the Save As… button. Enter a file name and choose a location for the form template file, and 

then click the Save button. You are automatically returned to the Data Center. 
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7. If you did not use the Save As option, click the OK button to return to the Data Center and 

process your forms. 

Reviewing Exceptions Overview 

As forms are processed, exception cases can occur. You should Edit cells containing exception cases to 

validate your data before performing any analysis operations or exporting the data to another application. 

Each exception case is assigned a specific color so that you can easily distinguish different types of 

exceptions. The following table summarizes the types of exception cases and their possible causes. 

  

Error Type Text Color Possible Causes 

Multiple Responses 

(Too Many Responses) 

All multiple 

responses or 

MULT (depending 

on your template 

settings) 

Green More than one answer selected when multiple 

responses are not permitted. 

Partially erased forms. 

Carelessly marked forms. 

Blank Responses 

(No Response) 

BLANK Yellow Unanswered questions. 

Response not completely filled. 

Input Regions None Light Blue Signifies an input region where you need to type 

the information found in the region. 

Database Lookup Errors Selected 

Responses 

Purple Response not found within the selected database to 

which the region is linked. 

Barcode Errors ??? Dark Orange The OMR scanner cannot read the barcode. It could 

be misplaced on the form or a barcode type that 

the scanner is not capable of reading. Check your 

OMR scanner manufacturer’s user’s guide for 

information about supported barcodes. 
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Error Type Text Color Possible Causes 

Required item None Exception 

Color 

Signifies that a required region was not properly 

answered. Typically, this means that another 

exception occurred, such as a Blank, Mult or Error. 

The data grid cell takes on the color of this 

exception (e.g., yellow for a blank response), but 

there is no text, indicating that the question was 

required. Flagging required questions is particularly 

useful when you use the Review Exceptions function 

during form processing (meaning the processing 

stops so that you can Review the problem). Note 

that you should use caution when making questions 

required and using the "Flag Blanks" setting. If Flag 

Blanks is set to Never, anything left blank does not 

display as a required item exception. 

Multiple exceptions None Gray Signifies that multiple exceptions were found in the 

region. For example, a barcode region that is also 

being used as a Database Lookup region might not 

be recognized properly. In this case, it is both a 

barcode recognition exception and a Database 

Lookup exception. The gray color lets you know that 

more than one issue was found. 

 

 Note: The exception colors in the grid and links to stored images (if using an OMR/Image or 

Prisma scanner) are only retained if you save data to the Remark data formats. Once you export 

your data to another format, if you reopen that format, the grid colors are not present. 

Using Review Exceptions 

Remark Classic OMR provides the Review Exceptions feature as a method to validate data. You may use 

the Review Exceptions feature to Review the following exception cases: blank responses, multiple 

responses, barcode errors, database lookup errors, required items, multiple exceptions or Input regions. 

The Review Exceptions feature can be used in one of two ways: 

 

After Form Processing: Review Exceptions can be used after the forms have been processed; therefore, 

you are not required to have the software stop processing forms when exceptions are encountered. When 

reViewing after processing, the software cycles through the data file to find exception cases and then 

allows you to make the appropriate changes. To use Review Exceptions after form processing, select the 

REVIEW button in the data header bar across the top of the data grid. You may also select Review 

Exceptions from the task pane, toolbar or Tools menu.  

 Tip: When using Review Exceptions after form processing, you can Review the entire data set or 

sections of the data set. To review sections of the data set, select the column or row header(s) of 
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the area you wish to Review, or highlight a group of cells. For example, if you only want to Review 

a specific Input region so that you can hand enter data, select the column header of the comment 

region so that the entire column is highlighted. Then click Review Exceptions; only the selected 

column is reviewed. 

During Form Processing: If used during the reading process, Review Exceptions provides an option to 

have the Data Center pause after encountering selected exception types. You can then select or enter the 

correct response. To use Review Exceptions during form processing, turn it on in the Read window and 

choose the exceptions you want to correct. 

Regardless of how you use Review Exceptions, the software alerts you to the issue and allows you to make 

the appropriate updates in the data header bar. If you are using an OMR/Image or Prisma scanner and 

capturing scanned images, you can use the Image Viewer to assist you with the Review. The following 

table details the available Review Exceptions options:  

 

Review Option Function 

Blank Responses Review when a respondent fails to answer a question. 

Multiple Responses Review when a respondent chooses more responses than were permitted. 

Input Regions Review when a flagged Input region is encountered. Allows the hand entry or speech 

recognition of information into the data grid. 

Database Lookup 

Errors 

Review when a database lookup error is encountered, meaning that the response is not 

located in the database that was specified during the form template creation process. 

Once you correct the Database Lookup exception, if you are returning other fields from 

the database, they are updated automatically. 

Barcode Errors Review when Remark Classic OMR cannot read the barcode properly. 

Required Items Review when a required item has not been answered. 

Multiple exceptions Review when multiple exceptions occur. For example, a barcode region utilizing Database 

Lookup could be unrecognized, which would generate both a barcode exception and a 

Database Lookup exception. 

 

To use Review Exceptions 

1. Choose whether to Review during or after processing, as outlined above.  

2. Once you access Review Exceptions, use the task pane to select the exception cases you would 

like to Review: Blank responses, Multiple Responses, Input Regions, Database Lookup Regions, 

Barcode Regions, or Required Items. You can also choose whether to search by rows or columns 

in the data grid. 

3. Click the NEXT button to start the Review process. 
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 Note: You can optionally use speech recognition to assist you with reviewing exceptions. 

4. The Data Center searches the data for the specified exception cases. When a selected exception 

case is found, it appears in the data header bar at 

the top of the data grid. The bar is color coded to 

match the exception type (e.g. yellow for a 

BLANK response). Use this window to make 

changes. If you are using an image enabled 

scanner and capturing scanned images, you can 

use the Image Viewer to assist you with the 

Review. You can use the drop-down list if 

applicable, or type a response. Note if there is a 

list of answer choices defined, as you begin 

typing, Remark Classic OMR attempts to auto-fill 

your answer based on your possible answer choices. 

5. Once you have selected the appropriate response, press Enter on the keyboard or click the NEXT 

button. If you want to move to the next row of data instead, click the down arrow on the NEXT 

button and choose Go To Next Record. If you need to revisit the previous exception, click the 

PREVIOUS button. To go to the previous data record, click the down arrow on the PREVIOUS 

button and choose Go To Previous Record. 

6. Continue reviewing exceptions in this manner. 

7. Once you have finished reviewing, or if you click END REVIEW, if you made changes to the data, 

you are prompted to save the changes (note that if you did not make any changes, you are simply 

prompted to end the Review process). Click the Save Changes button to save your changes. Click 

the Discard Changes button to undo all changes made during the Review Exceptions session. 

Click the Cancel button to return to Review Exceptions. 

 

Additional Things to Know About Review Exceptions: 

There may be times when you are reviewing exceptions and the exceptions are legitimate, e.g. a question 

is left blank. By default, if you leave the exception as is, 

it always retains the color coding and exception text. If 

you prefer to remove the color coding once an item 

has been reviewed, go to Tools|Preferences and mark 

the checkbox for Clear exceptions after they have 

been reviewed in the section called Review 

Exceptions. After a cell is reviewed using Review 

Exceptions, the color disappears even if you did not 

make a change to the cell. If Review Exceptions is run 

again, the cell is not flagged as an exception. 

If you Review data and then either start a new read 

process or open a data file, when you run Review 

Exceptions again, the software prompts you to read all 

the exceptions or begin from the last Review session. 

This feature can be a nice time saver if you have already reviewed the data, in which case you can choose 

Yes when the message appears to read from where you last read data. 
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If you are using an OMR/Image or Prisma Scanner, in order to retain the link between the data and the 

corresponding image in the image viewer, you must save the data to the Remark (RMK/RMX) formats. If 

you plan on continuing your data Review at a later point, save the data to one of these formats so that 

when you resume Review Exceptions, you'll still have the form images in the image viewer. 

If you need to Review Input regions, you can use the speech recognition portion of Review Exceptions by 

clicking the microphone. 

Speech Recognition 

Remark Classic OMR includes the ability to use speech recognition when running Review Exceptions. This 

feature is particularly Helpful if you have Input regions on your form that have long comments. Instead of 

clipping or typing the comments, you can use the image viewer on-screen and read the comments into 

the data grid. You can also use speech recognition to review other data types during Review Exceptions 

(e.g., actual answer choices from an OMR region). Ensure that you understand how to use Review 

Exceptions before attempting speech recognition. 

Speech recognition relies on the Microsoft Windows built-in speech technology. Gravic has no control 

over the effectiveness of speech recognition. We strongly suggest you train your computer to recognize 

your voice using the Microsoft speech training options in the Windows Control Panel. If you encounter 

difficulties with speech recognition, ensure you have a good quality microphone and that you have 

conducted the speech recognition training. For speech recognition troubleshooting, consult the Microsoft 

website. 

You may use the following commands when using speech recognition in Review Exceptions: 

  

Next: Moves to the next exception 

Previous: Moves to the previous exception 

Finish: Ends the Review process 

  

To use speech recognition 

1. In the Remark Classic OMR Data Center, process forms or open a data file. 

2. To begin speech recognition, first ensure you have a microphone attached to the computer and 

configured in the Windows Control panel. Then 

click the REVIEW button in the data header bar. 

3. Click the microphone next to the red END 

REVIEW button.  

 Note: If you want to enter comments into a 

specific Input region, highlight the column 

representing the Input region before 

starting speech. 

4. If necessary, choose the exception types to 

Review in the left task pane. 
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5. When you are ready to start speech recognition click or say the word NEXT. Remark Classic OMR 

locates the first exception based on the types of exceptions you are reviewing and any portions of 

the grid you have selected (if applicable). 

 If reviewing a multiple choice style question, speak the correct answer choice. You must say a 

valid answer choice for the question, as defined in the Labels in the template, for Remark 

Classic OMR to record your response. 

 If reviewing an Input region, use the Image Viewer to read what you see on the screen. 

 Note: If something is not interpreted correctly, you can place your cursor in the data 

header bar and re-read information. 

6. Click or say NEXT to continue. 

7. Continue in the same manner until you wish to end Review Exceptions. If you need to end 

reviewing early, click END REVIEW or say Finish. 

8. If you made changes to the data, you are prompted to save the changes. Click the Save Changes 

button to save your changes. Click the Discard Changes button to undo all changes made during 

the Review Exceptions session. Click the Cancel button to return to Review Exceptions.  

Saving Data 

You can save the data in the data grid to dozens of different file formats. The Remark file format was 

specifically designed to optimize the data storage process in the Remark Classic OMR software. Saving 

data is also sometimes referred to as exporting data. 

 Tip: When working with data in Remark Classic OMR, use the Remark file formats (RMK or RMX). 

This is the only format that preserves the exception colors and links to the scanned images (if 

using an OMR/Image or Prisma scanner). Export data to other formats after you have collected 

and cleaned all of your data. 

When saving data, you have the option of using Save Data or Save Data As. The Save Data option can be 

used to save a data set for the first time or to overwrite the current data set. The Save Data As option 

allows you to save the current data set with new parameters (e.g. new file name, different folder, different 

file type, etc.).  

 Tip: If you open a data set and add new records to it, make sure you overwrite the data file if 

using Save Data As (you are prompted to overwrite or append). Do not append in this case, or the 

old data will be repeated in the data file. Ideally once your new records are added to the old data, 

simply click FILE|Save or the Save toolbar button, which overwrites the data file with exactly what 

you see on the screen. 

The following table lists the different save file formats, their extensions and a brief description: 
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file Format Extension Description 

Remark Extended RMX Remark extended format; saves grid exception colors and image 

links*; includes information about changed responses for associated 

reports in Remark Quick Stats (*image enabled scanners only) 

Remark RMK Remark format; saves grid exception colors and image links* (*image 

enabled scanners only) 

SQL Server MDF Microsoft SQL Server format 

Oracle 7.4 and later *.* Oracle format 

Access 2007-2016 ACCDB Microsoft Access 2007 - 2016 format (only available if the Microsoft 

Office 2007 or greater database engine is installed)  

*Note: If you are running a 64-bit version of Microsoft Office, you 

may install the 32-bit Office engine alongside of it. 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format 

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format 

Excel 2016 XLSX Microsoft Excel 2016 format  

Excel 2013 XLSX Microsoft Excel 2013 format  

Excel 2010 XLSX Microsoft Excel 2010 format  

Excel 2007 XLSX Microsoft Excel 2007 format  

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Questionmark QSF Perception Questionmark format (save only) 

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 

Survey Pro SRV Survey Pro standard format (Apian Software) 

Survey Pro STL STL Survey Pro STL format (Apian Software) 
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file Format Extension Description 

CSV CSV Comma separated values format 

Text TXT Tab delimited text format with quotes around textual data 

Opinionmeter ASC Comma delimited format for Opinionmeter application 

StatPac DAT StatPac format for StatPac Survey Software 

Survey System DAT The Survey System format (Creative Research Systems) 

dBase V DBF dBase V format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 7-8 DB Paradox 7-8 format; requires the Borland Database Engine (BDE) to 

be installed 

Paradox 5.X DB Paradox 5.X format; existing files may only be overwritten (there are 

no append options) 

Paradox 4.X DB Paradox 4.X format; existing files may only be overwritten (there are 

no append options) 

Paradox 3.X DB Paradox 3.X format; existing files may only be overwritten (there are 

no append options) 

Lotus WK3 WK3 Lotus Works 3 format 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus WJ3 WJ3 Lotus 1-2-3 version 3 format 

Lotus WJ2 WJ2 Lotus 1-2-3 version 2 format  

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated to specified record 

length 

Data Interchange Format DIF Standard format using file header and data section 
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file Format Extension Description 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language 

ODBC *.* Open Database Connectivity 

Custom  ASC, TXT Custom Text format 

Database Update  XLS, XLSX, 

MDB, ACCDB 

Updates an existing database with new data (e.g., adds missing 

information, overwrites existing information). 

ODBC Database Update  *.* Updates an existing ODBC database with new data (e.g., adds 

missing information, overwrites existing information). 

  

To save data 

Before saving data to another data format, we suggest saving a copy of the data to the Remark (RMK or 

RMX) format to preserve exception colors and links to scanned images (if using an image enabled 

scanner). Once your project is complete, you may delete or archive the Remark file. 

 Note: When exporting to a specific format (e.g., Access, Excel, etc.) make certain your data 

meets the format's specific requirements. 

1. After processing forms, select the file menu and then click Save Data if saving the data set for the 

first time or to overwrite the data. Click Save Data 

As to save the data with new parameters. 

 Note: Clicking the toolbar button for Save Data 

overwrites the current data set. 

2. If saving for the first time or using Save Data As, the 

Save Data window opens, allowing you to choose a 

file name, a file type, the folder in which you would 

like the file saved and Advanced saving options. 

3. Select the desired folder location using the Look in 

drop down box. 

4. Enter a name in the box titled file name. 

5. Select the desired output format in the box titled 

Save as type. 

6. If saving to a database type that supports internal table names, enter a table name in the box 

titled Table name. 

 Note: Each database format has different table name limitations. Refer to your database 

documentation for information on table name limitations. When saving to a database where 
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one or more fields are too small to hold the data being saved, Remark Classic OMR attempts 

to resize the database column so that it can hold the data being saved. 

7. When exporting, you can save the column headers for certain formats by selecting the Save 

headers checkbox. The Save headers checkbox only displays when appropriate. 

8. Click the OK button to save the file. The data is saved to the format and location of your choice.  

 Tip: If you use Google Drive or Dropbox, once you select the format and give the file a name, 

you can click the Google Drive or Dropbox icons in the Save window to place the file right in 

your Google Drive or Dropbox folder. If your computer is set up to automatically poll this 

folder for files, Google Drive or Dropbox will "see" the file and upload it to the cloud 

automatically. You must have Google Drive or Dropbox installed on your computer for this 

save to work. 

 Note: The Remark products are not affiliated with or otherwise sponsored by Dropbox, Inc.  

Advanced Data Saving Options 

When saving data to certain formats, you have the option of setting advanced parameters. The Advanced 

Save window shows you each question and pertinent information about the question (region). You can 

then choose options about the region that you want included in your database. This feature can be useful 

if you are saving to a database format that has specific requirements. You can temporarily override the 

form template settings by using the advanced parameters. The Advanced Save window also allows you to 

save either the scanned form image or path to the scanned form images to your data file (if using an 

image enabled scanner). 

 Note: Setting parameters in the Advanced Save window does not make any changes to the form 

template. 

  

To use advanced saving options 

1. Select the file menu and then click Save Data As. The Save Data window opens, allowing you to 

choose a file name, a file type, the folder in which you would like the file saved and advanced 

saving options. 

2. Select the desired folder location using the Look in drop down box. 

3. Enter a name in the box titled file name. 

4. Select the desired output format in the box titled Save as type. 

5. If saving to a database type that supports internal table or sheet names, enter a table name in the 

box titled Table/Sheet name. 

6. Click the Advanced button. 

7. [OPTIONAL] If you have previously saved a definition file for this data set, click the Load... button 

to locate the appropriate INI file containing your settings. Otherwise, continue to Step 8 to build a 

new data file. 

8. Make any desired changes in the Include, Name, Data Type or Size columns, as described here: 
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Option Description 

Include Mark this checkbox to include the region (question) in the data file. Note that you may include 

the paths to the stored images of each processed form. The last item(s) in the Name list is the 

form image(s) listed by page (e.g., Page 1 Image). Images are only available if using an image 

enabled scanner. 

Name Use this column to enter a new field name to be used in the exported data file, if desired. 

Changing the field name in this window does not affect the region's name in the form 

template. 

Data Type Use this column to change the data type for this question. 

Size Use this column to specify a field size for the data for this question. Do not specify a size that 

is smaller than what is in your data. 

 

 Note: You can save the path of the form images 

or the actual form images to the file by using the 

Advanced options. Scroll to the bottom of the 

Names list to mark the form images. If you want 

the actual image to be stored, change the data 

type to binary. If the data type is not binary, the 

path to the images is stored. Images are only 

available if using an image enabled scanner. 

9. [Optional] If desired, click the Save button to save the 

settings to a configuration file (.ini file). You can then 

open this configuration file for future save operations 

with this same form template. This feature can save 

time when saving future data sets. 

10. Click the OK button to save the changes. 

11. In the Save Data window, click the OK button to save the data.   

Save All Data 

The Save All Data feature allows you to save multiple open data sets to one combined file (as long as the 

data sets correspond with the same Remark template). This feature is useful if you need to store and 

analyze data both on an aggregate and individual level. By maintaining separate files you can easily report 

on an individual data set. However, by combining the individual data files into one, you can also report on 

the data as a whole without having to open each data set individually any time you want to analyze all the 

data. 
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To use Save All Data 

1. After reading forms or opening multiple data sets, select the file menu and then click Save All 

Data. The Data Sets window opens, allowing you to choose the open files you wish to include in 

the save operation. 

2. Mark the checkboxes of all data sets you wish to include in the save operation. You may use 

Select All to select all data sets in the 

list. Please note that the data set must 

correspond to the active form 

template in order for it to be included 

in the save operation. 

3. If needed, drag the row header area to 

move data sets into a different order. 

The order in which the files appear on 

the Data Sets window is the order in 

which they are saved. 

4. If any of the open data sets had 

changes made to them prior to the save operation and were not saved, you receive a warning. 

The warning lets you know that during the save operation, all of the data sets being combined are 

closed. Click Yes to continue or No to cancel the operation, allowing you to go back and save the 

individual files first.  

 Note: If you made changes to your 

original data files and want those 

changes to be saved, save the individual 

files before using Save All Data. If you 

choose to ignore the warning, the 

changes to the individual data sets are 

not saved.  

5. Click the OK button. 

6. Select the desired folder location using the Look 

in drop down box.  

7. Enter a name in the box titled file name. 

8. Select the desired file format in the box titled 

Save as type. 

9. If saving to a database type that supports internal table or sheet names, enter a table name in the 

box titled Table/Sheet name. 

10. Click the OK button to save the file. All selected data sets are saved to the file specified and 

closed in the data grid. The combined data set is opened.  
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Saving Data - Organize & Save 

The Organize & Save feature allows you to fine tune the data saving process by building dynamic file, 

folder and table names. Using the Organize & Save options, you can use information directly from your 

data set to name the data file, storage folder or table within the file.  

To use Organize & Save  

1. Select the file menu and then click Organize & Save. The Organize & Save window opens, 

allowing you to choose a file name, a file type, the folder in which you would like the file saved 

and table name saving options. The first step is to choose a file type and location for the data. 

2. Under Save file, click the ... (ellipsis) button to select a file name and format for your data. 

3. Select the desired folder location using the Look in drop down box. 

4. Enter a file name in the file name box.  

5. Choose the file format in the Save as type box. 

6. If choosing a database format, also enter a Table/Sheet Name. 

7. Click the OK button. 

8. In the Build Saved Data file area, go to the file base name area of the window. The name you 

set in the previous screen is listed as the file name. You may modify it by typing in the box. You 

may also use the drop-down list to add a 

region from the processed data to the file base 

name. Choose the region from the drop-down 

list and then click the Insert Data Into file 

Name button. For example, if processing 

student test forms, you could add a student 

name region that is being collected from the 

form so that your data file name includes the 

name of each student (each time the student 

name changes, a new data file is created). 

Remember to place your cursor in the 

appropriate spot for where you want the 

region information to be inserted.  

9. In the Destination folder area, you may 

choose to add a region from the processed data to the folder structure that holds the data file. 

Choose the region from the drop-down list and then click the Append Data Onto Folder Path 

button. Continuing with our example, if processing student test forms, you could add a teacher 

name or ID region that is being collected from the form so that your folder names include teacher 

identifiers. Each student's data from the data set would be stored in a separate folder based on 

teacher name or ID number. 

10. If using a database format that requires a table name, go to the Table Name area of the window. 

The name you chose for Table Name when initially setting up the file in Step 6 is listed as the 

Table Name. You may modify it by typing in the box. You may also use the drop-down list to add 

a region from the processed data to the file base name. Choose the region from the drop-down 

list and then click the Insert Data Into Table Name button. Continuing with our example, if 
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processing student test forms, you could add a teacher name region that is being collected from 

the form so that your data file table name includes the name of the teacher administering the 

test. Remember to place your cursor in the appropriate spot for where you want the region 

information to be inserted. 

11. If desired, mark the checkbox for Overwrite existing files or tables, in which case anything that 

exists in the same location, with the same name and format, is overwritten.  

12. Click the Save button to save the data. The data file(s) is saved based on your specifications. If 

you named files or folders based on data from your data set, you may see separate folders and 

files. For folders, there is a separate folder for each unique entry in your data set. Within each 

folder you find the appropriate data file. For data files, the data file names begin with the region 

data you chose during the set up process. 

Custom Format for Saving Data 

The Custom format allows you to create a customized text file. This format is useful for exporting data 

into a database or other program that has very specific requirements. The format can also be used to 

break apart rows of data into multiple records. For example, if you are processing an attendance sheet 

containing records for multiple students in a single row, you can use the Custom format to separate the 

data into one record for each student. 

 

To use the Custom format 

1. Select the file menu and then click Save Data As. The Save Data window opens, allowing you to 

choose a file name, a file type, the folder in which you would like the file saved and advanced 

saving options. 

2. Select the desired folder location using the Look in drop down box. 

3. Enter a name in the box titled file name. 

4. Select the Custom (*.ASC, *.TXT) format in the box titled Save as type. 

5. Click the OK button. 

6. If you have used the Custom format previously and have a saved configuration file that applies to 

this data set, click the ellipsis (...) button to locate the configuration file. Otherwise, continue to 

the next step 

7. Select the options you wish to use to customize your data set. Each option is described here:  
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Option Description 

Start export at row Enter the row number that you want to use as the first record in the exported data file. 

All rows from this point forward are included in the data file. Enter 0 to include region 

(field) names as the first record. 

file Type Delimited: Fields are separated by a delimiter, such as a comma or tab. 

Fixed-Width: Fields are aligned at fixed character spaces. 

Record Delimiter Sets the delimiter to be used to separate records: Carriage Return/Line Feed, Carriage 

Return, Line Feed or any other string. 

Column Delimiter Select the character to use to separate the columns in the data file: Comma, Tab, Semi-

colon, Space or any other string. 

Text Qualifier Select the character to use to qualify text. Textual responses are encapsulated within 

these characters. Options include: None, double quote ("), single quote ('). 

Multiple Response 

Qualifier 

Select the character to use qualify multiple responses. Reponses are encapsulated within 

these characters. Options include: Parenthesis (( )), Curly Braces ({ }), Square Braces ([ ]), 

Angle Brackets (< >) or any other single character. 

Multiple Response 

Delimiter 

Select the character to use to separate multiple responses. Options include Comma (,), 

Hyphen (“), Colon (:), Semi-colon (;), Space or any other single character. 

Fixed Width files Only: 

Automatically 

format questions 

that allow multiple 

responses 

Mark the Automatically format questions that allow multiple responses checkbox to 

automatically set formatting for questions that allow more than one answer choice (e.g., 

(1,2,3) becomes 123). Note that Remark looks at the longest answer choice and any 

answer choices that are shorter have padding added to them to make them the same 

length. For example, if the answers are 5, 10 and 3, it would look like 5 103. One space of 

padding is added after the 5 because 10 is the longest answer choice with two 

characters. This setting only applies to Fixed Width files. 

Field Size The maximum number of characters allowed in the field. 

Start Position The position, in characters, where the field begins. For example, if your field sizes are 25, 

the first field starts at position 1 and the second field starts at position 26 (25 characters 

later). This field is for reference only and cannot be changed. 

Pad Character Enter the character to use to pad the field (typically a space character). 

Pad On Select whether to pad the field on the left or right of the text that resides in the field. 
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8. Click the Next button to go to the next step. 

9. Use this step if you need to break your data apart into multiple records. This option is useful for 

things like attendance forms, session evaluations and any other forms that evaluate more than 

one person on a single form. If you do not need to break apart data, simply click the Finish 

button (step 14). 

10. Choose how many records you want in your data set. For example, if you are processing an 

attendance sheet and there are 20 students per form (row of data), you would enter 20. Click the 

Update button. The number of desired records are created on the right side of the window. 

11. You have three options for formatting the file: 

 Add to Every Record: Choose this option to add a question (or questions) to every record in 

the data set. In our attendance example, this might be a class name or teacher name 

(something that is static for everyone). 

 Add to Selected Records: Use this option to add questions to only the records you have 

selected on the right side of the window. This option lets you fine tune what goes into each 

record. 

 Split Among Records: Use this option to select questions and then have them equally split 

across all records. In our attendance example, this would be the questions that are used to 

track attendance (e.g., days of the week). For example, suppose you have students listed 

down the left side of the form and options for Monday-Friday for each student. If a student is 

in attendance, the corresponding bubble is filled. If the student is absent, the bubble is left 

blank (this is a Boolean region). You can split the students among all the records. Then split 

each day among all the records. See screen shot at right. If your data was not split, you might 

have something like this: 

 

Notice how the students and attendance are listed in one long row. 

 

However, if you split your data, you have this: 

 

 

 

 

 

 

Notice how each student is now occupying one record of data, along with his/her attendance. 

12. Using the above descriptions, parse your data as needed.  

13. Use the Preview button to preview how your data will look once exported. 



 

78 

 

14. When finished, click the Finish button. 

15. When the Save Configuration window appears, click the Yes button to save your settings to a 

file that you can use later when saving data. If you do not wish to save this configuration file, click 

the No button. If you are not saving the configuration file for later use, the data file is saved when 

you click the No button. Continue with the next steps if you are saving the configuration file. 

Otherwise you are finished saving your data. 

 [Optional] If saving the configuration file, in the Save Text Export Configuration As box, 

select a location in which to save the configuration file in the Save in box. 

 Enter a name for the file in the file name box. 

 Leave the Save as type box set to Text Export Configuration files (*.tec). 

 Click the Save button to save the TEC file and create the data file. 

  

The data is saved according to your specifications and you can reuse the TEC file in the future. The 

resulting text file can be taken to the application of your choice. 

Creating a Data Transform 

If you want to use Remark Quick Stats to analyze a subset or customized configuration of your data, you 

can use the Data Transform option. This option allows you to set up the same custom parameters and 

pass them into Remark Quick Stats so that your data can be analyzed. Normally the newly formatted file 

would require a new template to match, but the transform option does that for you. Note that if you want 

to analyze your data on multiple occasions, you will need to perform the transform option each time. You 

can use a saved custom text configuration file (.tec) when using the data transform option (you do not 

have to start from scratch). Note that the data transform option does not output a data file. If you want a 

saved data file you should use the Custom Format first (file|Save Data|Custom… see section above). 

 

To create a custom transform 

1. Scan forms or open a data file. 

2. If analyzing a survey, click the drop-down arrow on Advanced Survey and choose Create Data 

Transform. If grading a test, click the drop-down arrow on Advanced Grade and choose Create 

Data Transform. 

3. [Optional] If you previously created a transform file or saved data using the Custom Text option, 

you may use the ellipsis (…) to open the existing .tec file. The remainder of these instructions will 

focus on creating a new data transform. 

4. Click the Next button. 

5. Use this step if you need to break your data apart into multiple records. This option is useful for 

things like attendance forms, session evaluations and any other forms that evaluate more than 

one person on a single form. If you do not need to break apart data, simply click the Finish 

button (step 11). 

6. Choose how many records you want in your data set. For example, if you are processing an 

attendance sheet and there are 20 students per form, you would enter 20. Click the Update 

button. The number of desired records are created on the right side of the window. 

7. You have three options for formatting the file: 
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 Add to Every Record: Choose this option to add a region (or regions) to every record in the 

data set. In our attendance example, this might be a class name or teacher name (something 

that is static for everyone). 

 Add to Selected Records: Use this option to add regions to only the records you have 

selected on the right side of the window. This option lets you fine tune what goes into each 

record. 

 Split Among Records: Use this option to select regions and then have them equally split 

across all records. In our attendance example, this would be the regions that are used to track 

attendance (e.g., days of the week). For example, suppose you have students listed down the 

left side of the form and options for Monday-Friday for each student. If a student is in 

attendance, the corresponding bubble is filled. If the student is absent, the bubble is left 

blank (this is a Boolean region). You can split the students among all the records. Then split 

each day among all the records. See screen shot at right. If your data wasn’t split, you might 

have something like this: 

Notice how the students and attendance are listed in one long row. 

 

However, if you split your data, you have this: 

 

 

 

 

 

 

Notice how each student is now occupying one record of data, along with his/her attendance. 

8. Using the above descriptions, parse your data as needed.  

9. Use the Preview button to preview how your data will look once exported. 

10. When finished, click the Analyze or Grade button. 

11. When the Save Configuration window appears, click the Yes button to save your settings to a 

file that you can use later when saving data or creating a data transform. If you do not wish to 

save this configuration file, click the No button. Continue with the next steps if you are saving the 

configuration file. Otherwise you are finished creating your data transform. 

 Note: No data is saved. You are only saving the configuration settings to be used at another 

time. 

 [Optional] If saving the configuration file, in the Save Text Export Configuration As box, 

select a location in which to save the configuration file in the Save in box. 

 Enter a name for the file in the file name box. 

 Leave the Save as type box set to Text Export Configuration files (*.tec). 
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 Click the Save button to save the TEC file. 

13. Depending on your operation, Advanced Survey or Advanced Grade opens. Make the desired 

selections to analyze your data and run Remark Quick Stats. Please see the Remark Quick Stats 

User’s Guide PDF to learn more about these options (Start|All Programs|Remark Classic 

OMR|Documentation). 

Database Update Format for Saving Data 

The database update format allows you to update an existing database based on the data in the Remark 

Classic OMR data grid (Access or Excel). The data are matched to the existing database by the region 

names and a mapping process. When saving to this format, you map the regions in the Remark Classic 

OMR data to the fields in the existing database. You also choose a question to be the record identifier. If 

data corresponding to the unique record identifier exists in the database it is updated with what is in 

Remark Classic OMR when the identifiers are matched. For example, if you are conducting a survey that 

collects demographic information, and include for a respondent identifier on your form, you could use the 

identifier as the record ID to update an external database using the Database Update format. During the 

save process, Remark Classic OMR attempts to find the ID in the database and then updates the data 

fields associated with that respondent. If the ID is not found, you have the option of adding the record to 

the external database. 

 Note: The ODBC Database Update format works just as described here, but you can save to a 

database using an ODBC connection. 

  

To use the Database Update format 

1. Select the file menu and then click Save Data As. The Save Data window opens, allowing you to 

choose a file name, a file type, the folder in which you would like the file saved and advanced 

saving options. 

2. Select the desired folder location using the Look in drop down box. 

3. Select a file to update, which fills the file name box. 

4. Select the Database Update (*.ACCDB, *.MDB, *. XLSX, *.XLS) format in the box titled Save as 

type. 

5. Click the OK button. A window opens to walk you through the next few steps. 

6. If you have used the Database Update format previously and have a saved configuration file that 

applies to this data set, click the Load... button to locate the configuration file. Otherwise, go on 

to step 7. 

 Note: You are prompted to save a configuration file with your settings after saving the data. 

7. In the Update Options area, select the number of records contained in each row of the data set 

(e.g., if multiple respondents' answers are on a single form, you would have more than one record 

per data row). If each record in the data set corresponds to one respondent’s submission, use 1 

for the value. 

8. In the Update Options area, mark the Add database records for missing record identifiers 

checkbox if you would like to create new records in the database when an identifier is not found. 
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9. In the Field Mapping area, map the regions from Remark Classic OMR to the fields in the 

external database. The target database fields are listed in the first column, called Database Field, 

and the Remark Classic OMR regions (questions) 

are listed in the second column, called Grid 

Column. Use the down arrow in the Grid Column 

section to choose the appropriate field to map to 

the corresponding database field. 

 Note: Remark Classic OMR attempts to 

automatically map the fields based on the 

field/region names. Review the field mapping 

first and then make changes if necessary. 

10. Choose a field or fields to use as an identifier by 

marking the appropriate checkbox next to the field 

name. The identifier fields are used to match data 

from Remark Classic OMR to the external database. 

If a match is not found, the data is not added to the 

database (unless you selected this feature in step 8) 

and you receive a message. You may select more 

than one field to use as the identifier, in which case the data from all identifier fields must be a 

match for the record to be updated in the external database. 

11. Click the OK button to save the data. 

12. If any problems are encountered when updating the selected file, a message appears detailing the 

problems. If the database is updated successfully you receive a message telling you how many 

records were updated and asking you if you want to save the configuration file for later use (if 

you use this same template and external database again, you can save a configuration file and 

skip the mapping process). If you do wish to save the file, click the Yes button. Enter a file name 

and choose a location for the .ini file in the Save window that appears.  

Opening Data Files 

The Remark Classic OMR Data Center can open data saved in dozens of different file formats. We 

specifically designed the Remark file format to optimize the data storage process in the Remark Classic 

OMR software. The software is designed to work with data that is collected using a form template in 

Remark Classic OMR. Therefore, you must first open a form template and then open the corresponding 

data file. Once the data file is opened, you can save it to another format or location, or use Remark Quick 

Stats to analyze it. 

 Tip: When working with data in Remark Classic OMR, use the Remark file format (RMK or RMX). 

This format saves exception case colors and links to scanned images* (*image enabled scanners 

only). Only save data to other formats when exporting. 

The following table lists the different file formats the Data Center can open, their extensions and a brief 

description: 
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file Format Extension Description 

Remark Extended RMX Remark format; stores grid exception colors and image links*; 

includes information about changed responses for associated 

reports in Remark Quick Stats (*image enabled scanners only) 

Remark  RMK Remark format; saves grid exception colors and image links* (*image 

enabled scanners only)  

SQL Server 2000-2005 MDF Microsoft SQL Server format 

Oracle 7.4 & later *.* Oracle format 

Access 2007-2016 ACCDB Microsoft Access 2007-2013 format (only available if the 32-bit 

Microsoft Office 2007 or greater database engine is installed) 

*Note: If you are running a 64-bit version of Microsoft Office, you 

may install the 32-bit Office engine alongside of it. 

Access 2000-2003 MDB Microsoft Access 2000-2003 format 

Access 95-97 MDB Microsoft Access 95-97 format 

Access 2.0 MDB Microsoft Access 2.0 format 

Access 1.0 MDB Microsoft Access 1.0 format 

Excel 2016 XLSX Microsoft Excel 2016 format  

Excel 2013 XLSX Microsoft Excel 2013 format  

Excel 2010 XLSX Microsoft Excel 2010 format  

Excel 2007 XLSX Microsoft Excel 2007 format 

Excel 97-2003 XLS Microsoft Excel 97-2003 format 

Excel 95 XLS Microsoft Excel 95 format 

Excel 4.0 XLS Microsoft Excel 4.0 format 

Excel 3.0 XLS Microsoft Excel 3.0 format 

SPSS SAV SPSS 16 format 

SPSS Legacy SAV SPSS 6 format 
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file Format Extension Description 

Survey Pro SRV Survey Pro standard format (Apian Software) 

CSV CSV Comma separated values 

Text TXT Tab delimited text with quotes around textual data 

Opinionmeter ASC Comma delimited text format for Opinionmeter application 

StatPac DAT StatPac format for StatPac Survey Software 

dBase 5.0 DBF dBase 5.0 format 

dBase IV DBF dBase IV format 

dBase III DBF dBase III format 

Paradox 5.X DB Paradox 5.X format 

Paradox 4.X DB Paradox 4.X format 

Paradox 3.X DB Paradox 3.X format 

Lotus WK4 WK4 Lotus Works 4 format (open only) 

Lotus WK3 WK3 Lotus Works 3 format 

Lotus WK1 WK1 Lotus Works 1 format 

Lotus WJ3 WJ3 Lotus 1-2-3 version 3 format 

Lotus WJ2 WJ2 Lotus 1-2-3 version 2 format  

Lotus 1-2-3 WKS Lotus 1-2-3 format 

LXR Test MRG LXR Test format 

Report RPT Fixed format ASCII, cell text padded or truncated to specified record 

length 

Data Interchange Format DIF Standard format using file header and data section 

XML XML Extensible Markup Language format 

HTML HTM Hypertext Markup Language 
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file Format Extension Description 

ODBC *.* Open Database Connectivity 

 

To open grid data 

1. Open the correct form template. 

2. Select the file menu and then click Open Data 

to display the Open Data window. 

Alternatively, use the Open data file link from 

the task pane or Open Data button from the 

toolbar. 

3. Select a file from the list. Use the Look in box 

to locate saved data files. You may need to 

adjust the files of type list to find the desired 

file. 

 Note: The data contained in the file must 

correspond to the currently active form 

template or an error may occur. 

4. If opening a database file, select the 

appropriate table from the Table name drop-down list. 

5. Click the OK button to open the data file. 

 Caution: When opening a database file type, the Data Center attempts to match grid column 

headers (region names) to the database's field names. If any column headers cannot be 

matched, an error occurs. Grid column headers do not need to appear in the same order as 

the database fields. 

You may now read more forms, save the data to a new format or location or run Remark Quick Stats for 

analysis.  
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File Formats  

The following sections contain detailed information about each file format supported in Remark Classic 

OMR. 

Remark Format (RMK, RMX) 

There are two Remark formats: Remark (RMK) and Remark Extended (RMX). The Remark formats are 

proprietary to the Remark software and, therefore, can only be used in Remark applications. We 

recommend that you use the Remark file format as your default file format and only save to other file 

formats when exporting data to other applications. These formats save data grid exception colors and the 

links to the scanned images to make reviewing data easier (if using an image enabled scanner). In 

addition, the Remark extended format saves information about changed responses so that you can run 

reports in Remark Quick Stats to view how many times a response was changed or respondents who 

change responses frequently, which could be useful when grading tests.  

 Tip: The Remark formats are the only formats that preserve the exception case colors and the 

links to the scanned images* (*image enabled scanners only). We recommend exporting data to 

other formats only after you have fully cleaned your data. 

  

Extension  RMK, RMX 

Options (automatic)  Saving Images: The RMK and RMX formats automatically save the link 

between store images and the data. You may then refer to the image files to 

Review data later. This feature is only available if using an image enabled 

scanner. 

 Saving Grid Colors: The RMK and RMX formats automatically save the 

exception colors in the data, which are used in conjunction with Review 

Exceptions to clean your data. 

 Storing Changed Responses: The RMX format stores information about how 

many times a response was changed and how many times a respondents 

changed responses, which can be reported on Remark Quick Stats. 

Limitations  Proprietary to Remark software and cannot be used in other products. 
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Access Formats (ACCDB, MDB)  

The Access file formats are proprietary to the Access database program by Microsoft Corporation. Remark 

Classic OMR supports the Access version 1.0 through 2016 file formats. Column (region) names in Remark 

Classic OMR are used as field names when saving to an Access database. Remark Classic OMR can save 

data to a new Access database, add new tables to existing Access databases and append data to existing 

Access tables. 

  

Extension  ACCDB, MDB 

Options  Table Name: When saving to an Access database, you must select a table 

name to which to save the data. 

Limitations  Field (region) and table names can contain a maximum of 60 characters 

(including spaces). Field (region) and table names cannot include: leading 

spaces, periods (.), exclamation points (!), accent graves (`) and brackets ([]). 

 An Access table can hold a maximum of 255 fields. 

 All region (field) names must be unique. 

 An Access table record can hold a maximum of 2000 characters (excluding 

Memo and OLE object regions). 

 If saving data to an existing table, grid column headers (region names) in 

Remark Classic OMR must match table field names. 

 When Remark Classic OMR creates an Access table, textual fields can contain 

a maximum of 255 characters. If you would like a field to support more than 

255 characters, Edit the database in Microsoft Access and change the field 

type from a Text field to a Memo field. Alternatively, click the Advanced 

button in the Remark Classic OMR Save Data window and change the field 

type to Memo. 

 In order to see the latest formats, you must have the 32-bit Microsoft Office 

database engine installed, which you can find on the Microsoft website. If 

you are running a 64-bit version of Microsoft Office, you may install the 32-

bit Office engine alongside of it. 
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Comma Separated Values (CSV) Format 

The CSV file format is a generic textual format and can therefore be used by many different applications. 

Grid cells are delimited by commas. Grid rows are delimited by a carriage return line feed sequence. CSV 

is a good choice for importing data into other applications. 

  

Extension  CSV 

Options  Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the first record in the file. 

 Encoding: The Encoding lists allows you to choose the type of character 

encoding you want to use. You should find out the requirements of your data 

analysis package before choosing an encoding type. Choices include: 

o System Default: Use the Windows default encoding type (if you are 

uncertain about encoding, we recommend you use this setting). 

o ASCII: Standard encoding scheme that encodes 128 specified characters 

into 7-bit binary integers. 

o Big Endian Unicode: UTF-16 variable-length encoding capable of 

encoding 1,112,064 possible characters into Unicode. 

o Unicode: Consistent encoding option that encodes 110,000+ plus 

characters. It is especially good for international characters, such as those 

found in the Arabic and Hebrew languages. 

o UTF32: Fixed length encoding that uses exactly 32 bits per Unicode code 

point. 

o UTF7: Variable length encoding for representing Unicode text in a stream 

of ACSII characters. It was often used in email, but has lost popularity. 

o UTF8: Variable length encoding capable of encoding all possible 

characters in Unicode. Designed for backward compatibility with ASCII. 

Limitations  When saving a CSV file, which is comma delimited, other applications may 

have difficulty opening the file if the data contain multiple responses. Multiple 

responses typically contain commas, which are also used as cell delimiters. 

Consider using the Custom format if you have questions that allow more than 

one response in the same data cell. 

 

 

 

 



 

88 

 

Data Interchange Format (DIF) 

The Data Interchange file format is a "standard" method of exchanging data between non-compatible 

programs. By its nature DIF cannot support program-specific information, such as cell formats. 

  

Extension  DIF 

Options  None 

Limitations  None 

dBase Format (DBF) 

The dBase file formats are commonly used database file formats used to transfer information between 

applications. Remark Classic OMR supports dBase version III, IV, and V file formats. Column (region) 

names in Remark Classic OMR are used as field names when saving to a dBase table. A dBase database is 

represented by a directory. A dBase table is represented by a DBF file within a dBase database. Remark 

Classic OMR can save data to a new dBase table and append data to existing dBase tables. 

  

Extension  DBF 

Options  None 

Limitations  Region (field) names can contain a maximum of 10 characters (including 

underscores). 

 Spaces in region (field) names will be automatically converted to 

underscores. 

 All region (field) names must be unique. 

 Region (field) names cannot include punctuation. 

 A dBase table can hold a maximum of 255 fields. 

 If saving data to an existing table, grid column headers (region names) in 

Remark Classic OMR must match table region names. 

 When Remark Classic OMR creates a dBase table, textual fields can contain a 

maximum of 255 characters. If you would like a field to support more than 

255 characters, Edit the database table in the dBase software program and 

change the region type from a Text region to a Memo region. Alternatively, 

click the Advanced button in the Remark Classic OMR Save Data window and 

change the field type to Memo. 
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Excel Format (XLS, XLSX) 

The Excel file formats are proprietary to the Excel spreadsheet program by Microsoft Corporation. When 

saving data, Remark Classic OMR supports the Excel version 97-2016 file formats. When opening data, 

however, you can go back as far as Excel 3.0. Column (region) names in Remark Classic OMR are used as 

field names when saving to an Excel spreadsheet. Remark Classic OMR can save data to a new Excel 

spreadsheet, add new sheets to existing Excel spreadsheet and overwrite existing Excel files. 

 Note: Older versions of the Excel formats have limitations, such as character limits and a 255 field 

limit. Use the 2013 format to avoid these limitations.  

 

Extension  XLSX, XLS 

Options  Sheet Name: When saving to an Excel spreadsheet, you must select a sheet 

name to which to save the data. 

Limitations  If saving data to an existing sheet, grid column headers in Remark Classic 

OMR must match spreadsheet field names. 

 In order to see the latest formats, you must have the 32-bit Microsoft Office 

database engine installed, which you can find on the Microsoft website. 

HTML Format (HTM, HTML) 

HTML stands for Hyper Text Markup Language. Use HTML to publish data and results from Remark Classic 

OMR to the Internet or an intranet. Remark Classic OMR saves data as well as graphs (from analysis 

reports) for inclusion in web based documents. 

  

Extension  HTM, HTML 

Options  None 

Limitations  None 
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Lotus Format (WKS, WK1, WK3, WK4, WJ2, WJ3) 

The Lotus file formats are proprietary to the Lotus 1-2-3 program by Lotus Development Corporation. 

Remark Classic OMR supports the Lotus 1-2-3, WK1, WK3 and WK4 formats. 

  

Extension  WKS, WK1, WK3, WK4, WJ2, WJ3 

Options  None 

Limitations  Data saved to a Lotus 1-2-3 version 2.0 format can have a maximum of 240 

characters per cell. Remark Classic OMR displays an error message (listing the 

cell location) if any cell exceeds 240 characters when saving to a Lotus 1-2-3 

file format. 

 If a cell contains any textual data, the entire column is saved as a string (text) 

rather than numeric data. 

 Data in the WK4 format can only be opened (not saved). 

LXR Format (MRG) 

The LXR Test format by Logic Extension Resources is a tab delimited ASCII file made for exporting data to 

LXR Test. The file contains a custom header followed by the data. Grid rows are delimited by a carriage 

return line feed sequence. 

 

 Extension  MRG 

Options  None 

Limitations  None 

Open Database Connectivity (ODBC) 

Open Database Connectivity, or ODBC, is a standard format independent of database and operating 

systems. ODBC works using an ODBC driver, which must be installed and configured correctly. Consult 

your database documentation for configuration and installation instructions. Once the ODBC driver is 

configured, you can select it in the Remark Classic OMR Save Data window during a regular save 

operation. For example, you can save to MySQL and MariaDB using the ODBC driver. 
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Extension  *.* 

Options  None 

Limitations  Consult your database documentation for specific format limitations. 

Opinionmeter Format (ASC) 

The Opinionmeter file format creates a text file for importing into the Opinionmeter application. Grid cells 

are delimited by commas. Multiple responses are encapsulated in parentheses. Grid rows are delimited by 

a carriage return line feed sequence.  

 

Extension  .ASC 

Options 
 Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the first record in the file. 

Limitations  None 

SQL Server  

The SQL Server driver is proprietary to the SQL Server database program by Microsoft. Remark Classic 

OMR can add new tables to existing SQL Server databases and append data to existing SQL Server tables. 

  

Extension  NA 

Options  Server: The SQL Server driver saves data to the server you specify. 

 Table Name: The SQL Server driver saves data to the table within the database 

you specify. You may create new tables or save to existing tables. 

 Login: You may log in to the database for security purposes. 

Limitations  Consult the SQL Server database documentation for specific format limitations. 
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Oracle  

The Oracle driver is proprietary to the Oracle database program by Oracle. Remark Classic OMR can add 

new tables to existing Oracle databases and append data to existing Oracle tables. 

  

Extension  NA 

Options  Server: The Oracle driver saves data to the server you specify. 

 Table Name: The Oracle driver saves data to the table within the database you 

specify. You may create new tables or save to existing tables. 

 Login: You may log in to the database for security purposes. 

Limitations  Consult the Oracle database documentation for specific format limitations. 

Paradox Format (DB) 

The Paradox file formats are proprietary to the Paradox database program by Borland International, Inc. 

Remark Classic OMR supports Paradox version 3.X, 4.X, and 5.X, 7 and 8 file formats. Column (region) 

names in Remark Classic OMR are used as field names when saving to a Paradox database. Remark Classic 

OMR can save data to a new Paradox database or overwrite existing tables. 

  

Extension  DB 

Options  Primary Index: When saving to a Paradox database, you must select a field to 

use as the primary index. 

Limitations  Primary Index: You must select a field to use as a primary index. A primary 

index must contain a unique value for every record. 

 For Remark Classic OMR to save data to a Paradox table, the ParadoxNetStyle 

must be set to the selected Paradox save format. (See your Paradox database 

documentation for more information on the ParadoxNetStyle property.) 

 All region (field) names must be unique. 

 A Paradox table can hold a maximum of 255 fields (columns). 

 A Paradox record can hold a maximum of 10,800 bytes. 

 If saving data to an existing table, grid column headers (region names) in 

Remark Classic OMR must match table field names. 
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 When Remark Classic OMR creates a Paradox table, textual fields can contain 

a maximum of 255 characters. If you would like a field to support more than 

255 characters, Edit the database in Paradox and change the field type from a 

Text region to a Memo field. Alternatively, click the Advanced button in the 

Remark Classic OMR Save Data window and change the field type to Memo. 

Questionmark Format (QSF) 

The Questionmark format is proprietary to the Questionmark Perception assessment software program. 

This format has specific parameters that must be defined, including a Snapshot ID (the value that uniquely 

identifies the assessment) and the Participant (the region that identifies each respondent). Additionally, 

there are optional parameters you may specify, including the Group, Details, Date and Monitor. This 

information should closely match what was originally defined in Perception. For example, the Snapshot ID 

used should already be defined in Perception as the ID for this particular form, the Participant IDs should 

already be defined in Perception as the student identifiers, Group should already be defined, Questions 

should already be defined in the same order as they appear in this form, Special fields should already be 

defined in the appropriate order and Details should already be defined (as to what type of information the 

field should contain). Please see the table below for further details. 

 

 Extension  QSF 

Required Parameters  Snapshot ID: A value that uniquely identifies the assessment. Each record in 

the data file must contain the same Snapshot ID. The Snapshot ID must be a 

numeric value from 1 to 99999999. Choose a field containing the Snapshot 

ID or enter one manually. 

 Participant: Participant, student or respondent identifier. This field uniquely 

identifies each respondent. Every record in the data file must contain a 

unique Participant identifier. Choose the field containing this information. 

Optional Parameters  Group: Group, category, course or department. This entry should match the 

groups defined in your Questionmark application. Choose the field 

containing the group or enter a group name manually. 

 Details: Optional demographic data. Choose the field containing the details 

or enter a value manually. 

 Date: Date the assessment took place. Choose a field containing the date or 

enter one manually. 

 Monitor: Monitor, teacher or instructor name. Choose the field containing 

the monitor name or enter one manually. 

Limitations  The Questionmark format is only available when saving data. You may create 

new files or overwrite existing files, but you cannot open the files in Remark 

Classic OMR. 
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 Region names cannot contain double quotes ("). 

 Spaces entered before or after a region name or data label will be ignored. 

However, spaces in the middle of a region name or data label will be 

counted. ” 

 Graded questions MUST use region names of "Q1, Q2, Q3..." or "Question1, 

Question2, Question3..." 

 You may optionally define questions called "Special1 - Special10" that can 

contain more optional demographic data. 

 The following fields can contain a max of 50 characters (any more will be 

truncated): Participant, Group, Details, Monitor, Special1 - Special10. 

 All exceptions should be corrected before exporting to this format. Any 

exception found in the graded questions when exporting is treated as an 

unanswered question. 

Report Format (RPT) 

The Report file format is a fixed width ASCII file. Each cell is padded, if necessary, to the specified length. 

Grid rows are delimited by a carriage return line feed sequence. The specified record length is written to 

the beginning of the file followed by the actual data. 

  

Extension  RPT 

Options  Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the first record in the Report data file. 

 Record Length: The Record Length option in the Save Data window allows 

you to choose the fixed length of each piece of data written to the file. 

Limitations  If any cells contain data longer than the specified record length, Remark 

Classic OMR displays an error message that lists the cell location. 

SPSS Format (SAV) 

The SPSS file format is proprietary to the SPSS statistical software program by SPSS, Inc. The column 

headers (region names) in Remark Classic OMR are saved as SPSS variable names. The question text, if 

entered, is saved as SPSS variable labels. Remark Classic OMR uses the Labels and Values defined when 

creating the form template as SPSS value labels and value numbers, respectively. Missing, invalid or 

unrecognized responses in Remark Classic OMR are assigned an SPSS missing value of -1 by default. 

 Note: The SPSS file format outputs numeric data for each of your Labels. By default, Remark 

Classic OMR uses a sequential numbering scheme, called Values, which begins with 1 for the first 

Label. You may change these values in the form template by selecting a question's properties. 
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Extension  SAV 

Options  Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the header names in the SPSS data 

file. If Save Headers is not selected, default variable names are used (e.g., v1, 

v2, etc.). 

Limitations  Data saved to an SPSS format can have a maximum of 255 characters per cell. 

Remark Classic OMR automatically truncates any cell text that is greater than 

255 characters when saving to an SPSS file. 

 Labels (Value Labels in SPSS) can have a maximum of 60 characters. 

 Values: If custom Values are not defined during form template creation, 

Remark Classic OMR assigns Values in sequential order to use as SPSS Values. 

 Region names (Variable Names in SPSS) can have a maximum of 60 

characters. If a region name has more than 60 characters, it is truncated. 

 Region names cannot begin with a number. 

 Region names (Variable Names in SPSS) must be unique. If a region name is 

used more than once, SPSS converts the name to a standard naming 

convention (e.g., v1). 

 Question text (Variable Labels in SPSS) can have a maximum of 120 characters. 

 Questions that allow more than one response are broken into separate 

Boolean questions for each answer option and the answers are saved as a 

dichotomy of 1 representing selected and 0 representing not selected. The 

question is then defined as an SPSS multiple response set that can then be 

analyzed. (You do not have to set the question up as Boolean in the Template 

Editor; it is handled behind the scenes). 

SPSS Legacy Format (SAV) 

The SPSS file format is proprietary to the SPSS statistical software program by SPSS, Inc. We strongly 

recommend using the SPSS format (non-legacy) but if you require an older version of the format, you may 

use the legacy format. The older version does have more limitations. The column headers (region names) 

in Remark Classic OMR are saved as SPSS variable names. The question text, if entered, is saved as SPSS 

variable labels. Remark Classic OMR uses the Labels and Values defined when creating the form template 

as SPSS value labels and value numbers, respectively. Missing, invalid or unrecognized responses in 

Remark Classic OMR are assigned an SPSS missing value of -1 by default.  

 Note: The SPSS file format outputs numeric data for each of your Labels. By default, Remark 

Classic OMR uses a sequential numbering scheme, called Values, which begins with 1 for the first 

Label. You may change these values in the form template by selecting a question's properties. 
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Extension  SAV 

Options  Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the header names in the SPSS data 

file. If Save Headers is not selected, default variable names will be used (e.g., 

v1, v2, etc.). 

Limitations  Data saved to an SPSS format can have a maximum of 255 characters per cell. 

Remark Classic OMR will automatically truncate any cell text that is greater 

than 255 characters when saving to an SPSS file. 

 Labels (Value Labels in SPSS) can have a maximum of 60 characters. 

 Values: If custom Values are not defined during form template creation, 

Remark Classic OMR assigns Values in sequential order to use as SPSS Values. 

 Region names (Variable Names in SPSS) can have a maximum of eight 

characters. If a field name has more than eight characters, it will be truncated. 

 Region names cannot begin with a number. 

 Region names (Variable Names in SPSS) must be unique. If a region name is 

used more than once, SPSS will convert the name to a standard naming 

convention (e.g., v1). 

 Question text (Variable Labels in SPSS) can have a maximum of 120 characters. 

 Remark Classic OMR can open and save to an uncompressed SPSS format 

only. Remark Classic OMR cannot open compressed SPSS files. If you need to 

uncompress your SPSS file, first open the file in SPSS. Select the file menu and 

click Save As. Enter a file name and then click the Paste button. In the Syntax 

Editor window, change the word "COMPRESSED" to "UNCOMPRESSED". Press 

Ctrl+A to select the text, then select the Run menu and click Current. 

 SPSS cannot import multiple responses (e.g., (A,B,C)) as numeric data. 

Questions that allow multiple responses in Remark Classic OMR will be 

formatted as a string when exported to the SPSS file format, which will not 

import properly. To import questions that allow multiple responses into SPSS 

as numeric data, set the questions up as Boolean OMR regions in the form 

template. As a result, Remark Classic OMR will output the responses to 

separate cells (each answer choice will be treated as a individual question in 

the data grid). Once the data have been opened in SPSS, you can combine the 

data for each answer in the question back into one question. Refer to the SPSS 

User's Guide for more information. 
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StatPac Format 

StatPac data files are fixed format sequential ASCII files with a carriage return and line feed at the end of 

each line. When saving to the StatPac format two files are created: .dat and .cod. You import the .dat file 

into StatPac but the .cod file is also required. Both files should have the same name up to the period 

before the extension. StatPac imports both Question Names and Question Text.  

  

Extension  DAT 

Options  None 

Limitations  You need both the .dat and .cod files when importing into StatPac. Ensure 

that the names up to the period are the same (Remark Classic OMR does this 

automatically for you when saving). 

 The StatPac format imports both Question Names and Question Text 

(optional). 

Text Format (TXT) 

The Text file format is generic and can therefore be used by many different applications. The text format 

similar to the CSV format with two differences: 

 The text format places quotes around textual data.  

 All text files are tab delimited 

  

Extension  TXT 

Options  Save Headers: The Save Headers option in the Save Data window saves the 

grid column headers (region names) as the first record in the Spreadsheet 

data file. 

Limitations  All text files are tab delimited with quotes around textual data. 

The Survey System (DAT, CRS) 

The Survey System file format is proprietary to The Survey System survey design and analysis software 

program by Creative Research Systems. When saving to the Survey System file format, Remark Classic 

OMR creates two files: a data file and a questionnaire definition file. To import the data into The Survey 

System, first import the questionnaire definition file (CRS extension) and then open the data file (DAT 
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extension) within that questionnaire. Consult The Survey System user's guide for additional information. 

Data may only be saved to The Survey System format (not opened in Remark Classic OMR). 

  

Extensions  DAT, CRS 

Options  None 

Limitations  You may create new data files or overwrite existing files only (not open data 

files in Remark Classic OMR). 

XML Format (XML) 

The XML format is used to save data to an XML file, which stands for Extensible Markup Language and is 

widely used for the exchange of data on the Internet. 

  

Extension  XML 

Options  None 

Limitations  Region (field) names can contain a maximum of 60 characters (including 

spaces). 

 Region (field) names cannot include: leading spaces, periods (.), exclamation 

points (!), accent graves (`) and brackets ([]). 

 An XML file can hold a maximum of 255 fields. 

 All region (field) names must be unique. 

 An XML record can hold a maximum of 2000 characters (excluding Memo and 

OLE object regions). 

 If saving data to an existing file, grid column headers (region names) in 

Remark Classic OMR must match field names. 

 When Remark Classic OMR creates an XML file, textual fields can contain a 

maximum of 255 characters. If you would like a field to support more than 255 

characters, Edit the file and change the field type from a Text field to a Memo 

field. Alternatively, click the Advanced button in the Remark Classic OMR Save 

Data window and change the field type to Memo. 
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Scantron Score 

Remark Classic OMR allows you to open test data collected with the Scantron Score™ scanner and 

perform additional test grading analysis. You will continue to scan test answer sheets with the Scantron 

Score, but can use Remark Classic OMR to run additional reports and add learning objectives to your test 

analysis.  

 

To use Scantron Score 

1. Open Remark Classic OMR by clicking Start|Programs|Remark Classic OMR|Remark Classic 

OMR Data Center. 

2. Select the File menu and then choose Import Scantron Score Data. Alternatively click Import 

Scantron Score data from the task pane on the left side of the main window. 

3. You have two options for obtaining the data: 

 If you have not yet scanned your 

forms, ensure you have set up the 

Scantron Score as your default 

scanner and then click the Get from 

Scanner… button. 

 If you have already scanned your test 

answer sheets with your Scantron 

Score scanner, click the Browse… 

button to locate the file you saved. 

4. Scantron Score files only include Student 

ID numbers as student identifiers. If you 

would like students’ names to appear on 

the test analysis reports, you may retrieve 

them from an Excel spreadsheet. You need to create this Excel spreadsheet outside of the Remark 

software (e.g., export student names from your student management system or type them into 

Excel). The Excel file should be formatted with the student ID number in one column and the 

student names (full) in a second column. Remark Classic OMR matches the student ID numbers 

found in the data file to those in the Excel file and uses the corresponding names on the reports. 

To use this feature, mark the checkbox for Retrieve student name from an Excel spreadsheet. 

5. Click the word Select in the grid column for Excel file to choose your file. Browse to the Excel file 

containing the student names. The software attempts to prepopulate the required fields based on 

what it finds in the file (if Name or ID are in the field headers, it tries to auto match them). If 

necessary, choose the correct Student ID field and Student name field from your Excel file. 

6. Click the OK button.   

7. [Optional] You may open multiple Scantron Score files if desired. 

8. [Optional] If desired, select the checkbox for Remove data files from the USB drive after 

import to PERMANENTLY remove the files from the USB drive. 

9. [Optional] If desired, select the checkbox for Automatically load test results to have Remark 

Classic OMR automatically grade the data and launch the reports (the software will only grade the 

last file if multiple data files are opened). 

10. Click the Import button. 
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11. If you chose to automatically load test results, Remark Quick Stats opens with the default reports. 

If you did not choose to automatically load test results, you can either click Quick Grade or 

Advanced Grade from the task pane (or toolbar) to grade the results. Remark Quick Stats grades 

the data based on the answer key located in the first row of the file. You can use Advanced 

Grade to analyze multiple data sets together (if they have the same Test ID) or apply learning 

objectives to the grade operation. 

 

Please see your Remark Quick Stats user’s guide for detailed information about using Advanced Grade 

and Remark Quick Stats. 

Emailing Data Overview 

You can email data files in their native formats or in ZIP format from the Remark Classic OMR Data Center. 

You have a choice of using Microsoft Outlook 2007 or greater or your own SMTP server (Custom) to send 

the emails.  

 Note: When emailing data, a local copy of the data is not saved. If you need to save a data file, 

make sure you take that step in addition to using the email function.  

  

Microsoft Outlook: 

If you plan to use Microsoft Outlook 2007 or greater, you do not need to set up anything outside of 

telling the software to use Outlook. When you email a data file, Outlook opens a new email with the data 

attached.  

 

Your SMTP Server: 

If you use your own SMTP server, you must have a valid SMTP server set up independently of Remark 

Classic OMR. SMTP stands for Simple Mail Transfer Protocol and is the Internet standard for transmitting 

email across networks. It is likely your organization has a running SMTP server already set up. You just 

need to find out general information about the server. You will need to consult with your network/email 

administrator to obtain information about your SMTP server. 

Click here to see how to choose your default email program. 

Using Outlook to Email Data 

Once you have set up your email preferences in Tools|Preferences, you are ready to start emailing data 

files.  

  

To email data files using Microsoft Outlook 

1. After processing forms, saving data or opening a data file, select the file menu and click Email.  

 Note: If you choose the toolbar option or task pane option to send email, the file is always in 

zipped format. 



 

101 

 

2. Choose Data as Attachment to attach the native file to an outgoing email message. Choose 

Data as ZIP Attachment to first zip the native data file (compress it into a .zip file) and then 

attach it to an outgoing email. The Email Data window appears. 

 Note: Your organization, or the recipient's organization, may have restrictions on the types of 

files that can be sent via email. If the file is restricted and you do not zip it, the email may 

never reach the intended recipient. If you are unsure whether the selected file type is 

restricted, use the ZIP option. The recipient must have a Zip program to unzip the file and 

view it. 

3. Choose the file name, file format using 

Save as type and if using a database 

format, the Table or Sheet name. You do 

not need to specify a location for the file, as 

it is automatically attached to an email 

message. 

4. Click the OK button. 

5. Outlook automatically opens a new email 

message with your file attached. You may now enter recipients and a message and send your file.  

 Note: if you chose to zip the file, it appears with a .zip extension. 

Using SMTP to Email Data 

Once you have set up your email preferences in Tools|Preferences, you are ready to start emailing data 

files.  

  

To email data files using your SMTP server (Custom) 

1. After processing forms, saving data or opening a data file, select the file menu and click Email.  

 Note: If you choose the toolbar option or task pane option to send email, the file is always in 

zipped format. 

2. Choose Data as Attachment to attach the native file to an outgoing email message. Choose 

Data as ZIP Attachment to first zip the native data file (compress it into a .zip file) and then 

attach it to an outgoing email. The Email Data window appears. 

 Note: Your organization, or the 

recipient's organization, may have 

restrictions on the types of files that 

can be sent via email. If the file is 

restricted and you do not zip it, the 

email may never reach the intended 

recipient. If you are unsure whether 

the selected file type is restricted, use 

the ZIP option. The recipient must 

have a Zip program to unzip the file and view it. 
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3. Choose the file name, file format using Save as type and if using a database format, the Table or 

Sheet name. You do not need to specify a location for the file, as it is automatically attached to 

an email message. 

4. Click the OK button. 

5. The Email Message window appears. 

6. Enter the recipient(s)' email address in the To box. Separate multiple recipients with a semi colon 

(;). 

7. Enter your return email address in the From box. 

8. Accept the default subject, which is the file name, 

or enter a new one in the Subject box.  

9. In the rich text box, type your message to the 

recipient(s). You may use the toolbar to format 

your message as desired. 

10. If you have already configured your SMTP settings 

in Remark Classic OMR you do not need to click 

the SMTP Settings tab. However, if you have not 

entered your SMTP settings or need to modify 

them, click the SMTP Settings tab to enter the 

SMTP server information. You will need to obtain 

this information from your network/email 

administrator. 

11. Click Send when you are ready to send your message.  

Your email message is automatically sent. The file is only saved as an email attachment; there is no 

permanent copy of the file saved on your computer when using the email functionality. If delivery 

problems occur, delivery reports are routed to the address listed in the From box of the email message 

(this may depend on how your SMTP server is configured to handle message failures). 
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Chapter 6: Remark Classic 

OMR Preferences  

Preferences Overview 

This section details how to customize the Remark Classic OMR software by setting up preferences. 

Preferences allow you to set the way the software functions by default, which can facilitate your use of the 

software. Please note that there are also preferences for Remark Quick Stats. 

 Important Note: The Preferences are global software settings. When you make a change to the 

Preferences, it affects all actions from that point forward. It does not affect anything you have 

already completed. 

  

To access the Preferences 

1. In the Remark Classic OMR Data Center, select the Tools menu and then click Preferences. 

2. Use the links in the left task pane to access all of the available preferences. Each item is described 

below and using the links to the left. 

3. Once you make a change, click the Apply button.  

4. When you are finished working with the Preferences, click the OK button to close the window.  

From this point forward, any changes you made take effect. Note that you may click the Defaults button 

at any time to return the settings back to their originally installed state. 
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Remark Classic OMR Preferences - 

General 

General preferences allow you to setup defaults for basic software functions. The following options are 

available: 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Preference Option Description 

Review Exceptions: Attempt to match typed 

response to the list 

Mark this checkbox so that you can type the first letter(s) of a 

response into the Response box of Review Exceptions and the 

software automatically selects the response that begins with those 

characters. This option applies to questions that employ list box 

style cells only (Multiple, List, and Boolean OMR regions and Input 

regions that utilize Database Lookup. 

Review Exceptions: Play a sound when the 

Review process begins  

Mark this checkbox to play a sound when Review Exceptions first 

starts. This feature is useful as an alert if you are processing forms 

in an unattended manner. 

Review Exceptions: Play this sound when an 

exception is located 

Mark this checkbox to play a sound every time an exception case is 

located in Review Exceptions. Click the … button to select a .wav 

sound file. You may also click the ... button to preview the sound. 
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Preference Option Description 

Review Exceptions: Clear exceptions after 

they have been reviewed 

Mark this checkbox to remove the color coding for an exception 

after it has been reviewed. This setting applies when you Review 

grid cells but do not make changes that would automatically 

remove the exception color (e.g., if a question is legitimately blank, 

you might leave it as BLANK with the yellow colored cell). By 

clearing the exceptions, Review Exceptions does not stop on them 

the next time it is run. 

Maximum length for a value in a data grid 

cell 

Enter the maximum number of characters allowed in a data grid 

cell. You are not able to enter more characters than allowed (e.g., 

when entering text using an Input region). Note that performance 

may be affected by data grid cells that contain very large amounts 

of text. 

Numeric data value used to represent 

invalid responses 

Enter the value to be used when invalid data are encountered 

during a data file export. Invalid data is anything that does not 

match the labels you defined in the template, such as error 

codes. If you typed a response in a list cell in the grid but it did not 

match the labels defined, this data would also be considered 

missing (e.g., "A" is defined in the form template, but you type "a"). 

The Missing Value is also used when running reports in Remark 

Quick Stats. The default value is -1. 

Numeric data value used to represent 

blank responses 

Enter the value to be used when blank data cells are encountered 

during a data file export. The Missing Value is also used when 

running reports in Remark Quick Stats. The default value is -2. 

Numeric data value used to represent 

multiple responses 

Enter the value to be used when multiple responses in data cells 

are encountered during a data file export (and are not allowed). 

The Missing Value is also used when running reports in Remark 

Quick Stats. The default value is -3. 

Database lookup & replace record limit The limit on the number of records loaded into the data grid’s list 

when using Database Lookup. If the limit is lower than the number 

of records in the database no data is loaded. The larger the limit 

the longer it takes to load the list. 

 

 

 



 

106 

 

Remark Classic OMR Preferences - 

Folders 

Folder preferences allow you to setup the default folders that are used to store image files if you are using 

and OMR/Image or Prisma scanner. If you prefer to store files on a network drive, you can enter that 

location here (ensure that you have permission to fully access that drive). Note that Remark Classic OMR 

uses a 'follow me' folder structure, meaning that it uses the last location you selected when saving and 

opening files in general (e.g. templates, data). The following options are available: 
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Preference Option Description 

Image Search Folders Sets the locations(s) in which images are stored for processed forms. 

When a cell in the data grid is clicked, the stored image file is displayed in 

the Image Viewer. The Image Viewer can be used for Review Exceptions 

and in-cell Editing. Use the Add Folder... button to add any folders in 

which you plan to store image files for processed forms. Remark Classic 

OMR searches for these images in the order in which the folders are 

specified. Use the Move Up or Move Down buttons to change the search 

order, and the Remove Folder button to remove a folder from the search 

list. Note that you can store images in any folder when processing forms. 

However, providing frequently used folders in the Image Search Folders 

List aids the Remark software in finding images to display whenever a 

data set is opened.  

Active Dictionary Sets the active dictionary to be used for Spell Checker. Click the down 

arrow to view any dictionaries that are currently installed on your 

computer. 

Remark Classic OMR Preferences - 

Display 

Display preferences allow you to set up aspects of how Remark Classic OMR looks. The following options 

are available: 
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Preference Option Description 

Shade alternating grid rows  Mark this checkbox and choose a color to shade every other Data 

Center grid row.  

Default row height Sets the height of the row based on font and screen resolution. 18 

is the default but you may set the number larger or smaller 

according to your preference. 

Update the Image Viewer after each image 

is processed 

Mark this checkbox to have the Image Viewer update with a new 

form image each time a form is processed. The Image Viewer is 

located beneath the data grid window. Using this option could 

alert you to issues such as skewed forms and is highly 

recommended. This option applies to OMR/Image and Prisma 

scanners only. 

Update the Graph Viewer after each image 

is processed 

Mark this checkbox to have the Graph Viewer update with a new 

graph per question each time a form is processed. The Graph 

Viewer is located beneath the data grid window. It provides a 

quick glimpse into your data by graphing the active question. 

Use a Custom Font Custom Font preferences allow you to set up the default fonts to 

use throughout the application. Mark the Use a Custom Font 

checkbox to choose a font to use throughout the application, 

allowing you to customize the software's look. You may choose a 

character set, font name and font size. You should choose a font 

that is supported by your operating system. Please note that not 

all fonts look optimal in the software. You should restart the 

application after making any font changes.  
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Remark Classic OMR Preferences - Email 

Email preferences allow you to set your internal SMTP server or Outlook as your default email program 

when emailing data and report files out of Remark Classic OMR (FILE|Email). When using Outlook, Outlook 

opens with your file(s) as an attachment. When using Custom (SMTP), a Remark Classic OMR email 

window opens that utilizes your SMTP server. 

SMTP stands for Simple Mail Transfer Protocol and is the Internet standard for transmitting email across 

networks. It is likely your organization has a running SMTP server already set up. You just need to find out 

general information about the server. You will need to consult with your network/email administrator to 

obtain information about your SMTP server. 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

To choose your default email program 

1. Select the Tools menu, then click Preferences, then Email. 

2. In the Email drop-down list, choose Custom to use your SMTP server or Outlook to use 

Microsoft Outlook 2007 or greater.  

3. If using your SMTP server, click the SMTP Server button and put in the settings as described in 

the table below for your SMTP server.  

4. Click the OK button to close the Preferences.  

To set up an SMTP server, please use the following table as a guide to have your administrator provide 

the proper settings: 
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Option Description 

SMTP server This is the name, address or IP address of the mail server. 

SMTP port The SMTP port is usually 25 but may vary with your email server. 

Enable a secured (SSL) 

connection 

If desired, use a secure connection by marking the checkbox for Enable a secured 

(SSL) connection. SSL encrypts data as it is transmitted. Your SMTP server must be 

configured to use SSL in order for this feature to work. 

Use the default 

credentials of the 

currently logged in user 

If you need to use authentication for your SMTP server, you can enter credentials or 

use those of the user logged in to the computer. Mark the Use the default 

credentials of the currently logged in user checkbox to utilize the user's credentials 

(e.g., the person logged in when sending the emails from Remark Classic OMR). 

Otherwise, continue to the next step to enter specific credentials. 

Username and Password If authentication is required, and you are not using the credentials of the currently 

logged in user, enter the Username and Password, as supplied by your 

network/email administrator. 

Throttle rate The throttle rate adds a delay while sending emails. The default setting is 500ms, 

meaning that one email is sent every 500 ms (in other words, two emails are sent per 

second). Throttling emails keeps the SMTP server from being overloaded when 

sending large numbers of emails. Unless you plan on sending hundreds of emails at 

one time, the default setting of 500 is likely fine. 

Remark Classic OMR Preferences - 

Speech 

Remark Classic OMR includes the ability to use speech recognition when running Review Exceptions. This 

feature is particularly helpful if you have Input regions on your form that have long comments. Instead of 

typing the comments, you can read the comments into the data grid. You can also use speech recognition 

to Review other data types during Review Exceptions (e.g., actual answer choices from an OMR region). 

Speech recognition relies on the Microsoft Windows built-in speech technology. Gravic has no control 

over the effectiveness of speech recognition. We strongly suggest you train your computer to recognize 

your voice using the Microsoft speech training options in the Windows Control Panel. If you encounter 

difficulties with speech recognition, ensure you have a good quality microphone and that you have 

conducted the speech recognition training. For speech recognition troubleshooting, consult the Microsoft 

website. 

The Speech preference in Remark Classic OMR allows tells you the commands you can use when using 

speech recognition in Review Exceptions: 
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Next: Moves to the next exception 

Previous: Moves to the previous exception 

Finish: Ends the Review process 

  

You can also click the Speech Recognition button to run through Microsoft's training process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remark Classic OMR Preferences - Data 

As changes are made to data in the Remark Classic OMR Data Center, they can optionally be logged, 

allowing you to see what changes were made and who made them. Logging is turned on and off in the 

Remark Classic OMR Preferences. It can only be turned off if you know the password used when turning 

on the feature. Changes made to the data grid (Edits, Review exceptions, Review duplicates, clipboard, 

open, save, etc.) are logged in a password protected Access database in the following location: 

C:\ProgramData\Gravic\Remark Classic OMR\Change logs (note you must have the option to show hidden 

folders and files on to see this location). 

When the database is initially created, it uses the date of creation as the Filename. From that point 

forward, all changes to all data files are stored in that Access file as long as the feature is turned on. Data 

file types, exception flags and actions are all listed with a numeric equivalent in the database. The 

additional tables in the database explain each of the numeric values. Once a database reaches 10MB in 

size, a new database is created the next time Remark Classic OMR is opened. 
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To turn on logging 

1. From the Remark Classic OMR Data Center, 

select the Tools menu, then click 

Preferences, then Logging. 

2. Mark the checkbox for Maintain Data 

Modification Log.  

3. Enter a password in the Password box. 

4. Click the OK button to close the 

Preferences.  

From this point forward, all changes to the data 

grid are logged. 

  

To turn off logging 

1. From the Remark Classic OMR Data Center, select the Tools menu, then click Preferences, then 

Logging. 

2. Enter the password that was set when turning on logging in the Password box. 

3. Click the Disable button. 

4. Click the OK button to close the Preferences.  

From this point forward, all changes to the data grid are not logged. If changes have been logged 

previously, the Access database still exists. 

 

You can also restrict changes that are made to the data grid.  Similar to the "Maintain Data Modification 

Log" feature, you turn on the data restriction feature by setting a password and turn off the feature by re-

entering the same password. If this option is turned on, users will not be able to Review data or Edit data 

in the grid. 

 

To restrict data modifications 

1. From the Remark Classic OMR Data 

Center, select the Tools menu, then click 

Preferences, then Data. 

2. Mark the checkbox for Restrict Data 

Modifications.  

3. Enter a password in the Password box. 

4. Click the OK button to close the 

Preferences.  

From this point forward, no changes to the data 

grid are allowed. 
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To turn off data modification restrictions 

1. From the Remark Classic OMR Data Center, select the Tools menu, then click Preferences, then 

Data. 

2. Enter the password that was set when turning on logging in the Password box. 

3. Click the Disable button. 

4. Click the OK button to close the Preferences.  

From this point forward, changes are allowed in the data grid.  

Remark Classic OMR Preferences - 

Updates 

Remark Classic OMR has the ability to automatically check for software updates. You can check at any 

time by clicking the Help menu and then choosing Check for Updates. You can also have the software 

check for an update every time it starts up. When this option is turned on, every time you start the 

software, it sends information about your current version to the update website and lets you know if there 

is a newer version of the software available. If an update is available, you are prompted to install it. The 

Check for Updates window also has the ability to do an immediate check for updates. 
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To automatically check for updates 

1. Select the Tools menu, then click Preferences, then Updates. 

2. Mark the checkbox for Check for updates when program starts to turn on the automatic check 

for updates. 

3. [Optional] If you would like to see if an update is available immediately, click the Check for 

Updates Now link. 

4. Click the OK button to close the Preferences. 

The next time the software is started, it automatically checks for an update. If an update is found, and you 

would like to install it, follow the on-screen prompts. You must have an Internet connection to download 

the update. If no updates are available you receive a message indicating that your software is up to date. 

Please note that in order for the update to install, you need to close Remark Classic OMR. You can either 

install the update as soon as it is downloaded, or continue working and when you close the software, the 

update will install itself. If the Remark Classic OMR Data Center or Template Editor are open, you are 

prompted to close them. Please save all work before allowing the install to continue. 

The Remark Classic OMR Automatic Update collects some system configuration data in order to provide 

you with updates that apply to your installation. This information includes: 

 Product Name  

 License Key  

 Remark Serial Number  

 Remark Authentication Code 

 Software Version and Build Number 

 System Finger Print (same as activation)  

Gravic, Inc. is committed to helping protect your privacy. Using the automatic update feature does not 

collect your name, address, email address, or any other form of personally identifiable information. Your 

Internet Protocol (IP) address is logged when you connect to the Gravic website, but this address is only 

used to generate aggregate statistics. 

Remark Classic OMR Preferences - 

Images 

PDF files are not native image files. However, they can be converted to an image format in order to read 

scanned forms. The Images settings are used to determine how best to convert these files to the most 

usable image format so that they both read well and display well (e.g. in Response reports). This setting 

applies when using an OMR/Image or Prisma scanner and saving the scanned images as PDF files. 
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To set Image Handling 

1. Choose the Bit Depth: Bit Depth is the color information stored in an image. The higher the bit 

depth, the more colors stored. For example, a 1 bit image only shows black and white. Choose 

whether your image is Color or Grayscale bit depth. 

2. Choose the Compression: Compression is used to minimize the size of an image without 

degrading its quality. Choose from the following options: None, CCITT Group 3, CCITT Group 4, 

Run-length encoding, JPG, LZW and Packed bits. Group 4 creates the most compressed image 

(smallest file size that take up less space on your computer). 

3. Choose the Resolution: Resolution is the detail an image holds and is measured in dots per inch 

(DPI). Higher resolution means more detail (and a larger file size). Choose from the following 

options: 150 DPI, 200 DPI or 300 DPI. 

4. Click the OK button to close the Preferences. 
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Chapter 7: Automation 

Control Center  

Automation Control Center Overview 

Remark Classic OMR includes an Automation Control Center that allows you to automate some of the 

functionality of the software. The Automation Control Center allows you to setup automation files that can 

be run by another user by simply double clicking a file. You can automate functions such as opening the 

software, opening a form template, processing forms, saving data, running reports and closing the 

software. This feature is useful for simplifying tasks for your users. 

The Automation Control Center is accessed from the Tools menu in the Remark Classic OMR Data Center. 

It walks you through the steps to set up a RCEZ file. Once that file is created, it can be double clicked to 

launch the associated actions on a computer running Remark Classic OMR. You can also call this file from 

other applications (this is outside the scope of Remark Classic OMR). Ensure that the folders and files you 

set up in the RCEZ file are universally accessible to your Remark users. 

 Tip: The Automation Control Center allows you to automate basic features of the software. These 

features are described in the main Remark Classic OMR user's guide and elsewhere in this 

document. Therefore, each feature will not be presented in detail here. You can learn about 

specific software features by locating them in the table of contents of this document. 

  

To create/modify a RCEZ file 

1. Select the Tools menu and then click Automation Control Center. 

2. Use the sections below to set up your RCEZ file.  

3. Once everything is set up, save the file. You have the following options: 

 Click the Save button to save the RCEZ file, but the Automation Control Center remains open 

for further modifications. 

 Click the drop-down arrow on the Save button and choose Execute. The RCEZ operation 

executes in a new instance of Remark Classic OMR. The Automation Control Center remains 

open for you to make further modifications or save your RCEZ file. Nothing is saved. 

 Click the drop-down arrow on the Save button and choose Save and Execute. You are 

prompted to save the RCEZ file first, and then the operation executes in a new instance of 

Remark Classic OMR.  

Once the RCEZ file is created, provide it to Remark users by placing it on the computer or embedding it 

into your own application. 
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Automation Control Center - General 

The first step in the Automation Control Center allows you to setup general software options. Once you 

make your selections, click the Open link in the left task pane to continue. 

  

 

 

 

 

 

 

 

 

 

 

 

 

Option Description 

Load The Load button provides two options: 

Load: Loads a previously saved Automation file so that you can 

make changes or execute it. 

New: Allows you to begin building a new Automation file (resets the 

Automation Control Center and all changes made previously are 

lost). 

Window State Configures how the main Remark Classic OMR window appears 

when the software is launched: 

Normal: Displays the software in its default state. 

Minimized: Leaves the software minimized on the desktop so that 

the user can easily continue doing other things while processes are 

being executed. 

Maximized: Displays the software full screen. 

Hidden: Runs the software in a hidden state so that the user does 

not see the software running. Most prompts are suppressed. 

Hide the splash screen Mark this checkbox to hide the splash screen that displays when the 

software is first launched. 
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Option Description 

Automatically exit after completing 

execution 

Mark this checkbox to have Remark Classic OMR automatically close 

once it has executed all of the parameters in the automation file. 

Use default folders when saving Mark this checkbox to have stored images saved to the folders 

specified in the software preferences. Images are only available if 

using an OMR/Image or Prisma scanner. 

Display the OMR scanner 

configuration on startup 

Mark this checkbox to show the scanner properties window when 

the software is launched so that the user can configure the scanner. 

Launch another automation file upon 

completion 

Mark this checkbox to launch another automation (RCEZ) file after 

this one completes. Use the ellipse (…) to choose that file. This 

feature allows you to chain automation files together to run multiple 

operations automatically. 

Automation Control Center - Open 

The Open window allows you to select which templates, data files and analysis definition files to open 

automatically. In addition, you can set up data saving options here. Once you make your selections, click 

the Scan in the left task pane to continue. 
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Option Description 

Template  Click the folder to select a form template to open automatically. You 

may open form templates (RCO), batch files (RBF/RBFX), Remark 

(RMK/RMX) data files.  

Analysis file Optionally, click the folder to open an existing answer key or survey 

definition file. This file is executed after forms are processed. 

Grading and Tabulation parameters are specified in the last step of 

the Automation Control Center. You have several options for the use 

of this file: 

1) If using Quick Grade or Quick Survey, the file selected in this step 

is used to produce the results. 

2) If using Advanced Grade, do not specify grading options in the 

last step of the Automation Control Center. Instead, if an answer key 

file is specified here in the automation file, you can run Advanced 

Grade manually (e.g., click the toolbar button, task pane option or 

menu option) and the specified answer key file is opened 

automatically. You may click Grade to grade the data or further 

configure the selected answer key file. 

3) If using Advanced Survey you need to run it manually (e.g., click 

the toolbar button, task pane option or menu option) and then the 

file specified here is automatically loaded into Advanced Survey. You 

may click Analyze to tabulate the data or further configure the 

selected survey definition file. 

Open Data Click the folder to select a data file to open automatically. You may 

open any one of the supported file formats. When opening and 

RMK/RMX files, the associated form template file opens with the 

data file automatically (note that the files must be in the same 

location as specified when saving the data in order for this to work). 

When opening data prior to processing forms, the newly processed 

data is added onto the end of the data file. You most likely want to 

overwrite the entire data file once you process additional forms in 

this case. 

Save Data (on Exit) Click the folder to select a data file for saving the data after forms 

are processed. You may choose an existing file or enter a new file 

name and format. Data from any open form templates is saved 

when the software is closed. This is the most common way to save 

data using an automation file. 

Overwrite Mark this checkbox to overwrite the data file(s) specified each time 

the automation file is run. 
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Option Description 

Add  Click the Add button to add another row where you may make 

further selections (e.g. open another form template, save to another 

data file, etc.). 

Delete Row Click the Delete Row button to remove the currently selected line of 

parameters. 

Show Organize & Save when saving 

data on exit 

Mark this checkbox to show the Organize & Save window if saving 

data when exiting the software. This feature allows you to customize 

the names used for data files and storage folders by utilizing data 

values from the active data set. 

Automation Control Center - Scan 

The Scan window allows you to select the parameters to use for scanning forms. Once you make your 

selections, click the Data Review or Image Archiving (only if using an OMR/Image or Prisma scanner) 

link in the left task pane to continue. 
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Option Description 

Read from Scanner Mark this checkbox to use the scanner to scan forms once a form 

template is opened. 

Disable scan prompts Mark this checkbox to disable any scanning prompts. Scanning begins 

without any interaction from the user. When the ADF is empty, 

scanning simply stops with no additional prompts. 

Scan single page only Mark this checkbox to only scan a single page placed in the scanner. 

Display custom scan prompt Mark this checkbox to enter your own customized scanning prompt. 

Enter the text you wish to display when scanning begins in the box 

below the checkbox. 

Activate Scanner Printing Mark this checkbox to print on the forms, then choose the item(s) you 

wish to print. Note that if printing grade information, you must scan the 

answer key first. 

Automation Control Center - Image 

Archiving 

The Image Archiving window appears if you are using an OMR/Image or Prisma scanner and allows you to 

select the parameters to use when saving images during scanning. Once you make your selections, click 

the Data Review link in the left task pane to continue.  

 

 

 

 

 

 

 



 

123 

 

Option Description 

Begin image names with Enter a file base name that the software can use to name the images 

stored for this form template as forms are scanned. You may use any 

name you like. We suggest using something that identifies to you that 

the images belong to a certain form (e.g. form template name). The 

images that are stored all begin with this base name and then have the 

page number (if larger than a one page form template), date and time 

appended to them to keep track of the various images. If you leave the 

Begin image names with option blank, your images only have the page 

number (if applicable), date and time as the name of each image. 

Target folder Click the ellipsis (...) to select a location in which to store the images for 

this form. You may use the default folder for images (stored in the 

software's preferences) or select a different folder. 

Name Builder The Name Builder button allows you to customize the image base names 

and storage folders for the scanned image files by pulling in data values 

from the active data set. In the Image Base Name area, you may choose 

to add a region from the processed data to the image base name. 

Choose the region from the drop-down list and then click the Insert 

Data into Base Name button. If you already added a region on the 

previous screen, the Name Builder allows you to add additional regions. 

For example, if processing tests, you could add a Student ID that is being 

collected from the form so that your processed images all have the 

Student ID number in them. 

In the Destination Folder area, you may choose to add a region from 

the processed data to the folder structure that holds the processed 

images. Choose the region from the drop-down list and then click the 

Append Data Onto Folder Path button. For example, if processing 

tests, you could add a Test ID that is being collected from the form so 

that each student's form images are stored in a folder containing the 

Test ID. 

In the Name Builder box, click the OK button to return to the 

Automation Control Center. 

Save image as Select an image type to use for storing images. The choices are: 

PCX/DCX, PDF, TIF or JPG. 

Color depth Choose the Color depth for the images: Black/White, Grayscale or Color 

(Black/White creates the smallest file). 

Compression level When saving to the PDF or TIF formats, you can choose the compression 

rate: Uncompressed, Group 3, Group 3 2d, Group 4 and LZW. Group 4 

creates the most compressed (smallest file size) image. 



 

124 

 

Option Description 

Save images in a subfolder based on 

the form template’s name 

Mark this checkbox to have Remark Classic OMR automatically create a 

folder in which to store these images. The folder name will be the name 

of the form template and the folder will be created in the folder you 

have selected in the Image target folder box. 

Save multi-page form templates as 

multi-page images files 

Mark this checkbox if you are scanning with a multi-page form template 

and would like all of the images for one complete form saved as one 

image file. 

Automation Control Center - Data 

Review 

The Data Review window allows you to specify whether to Review exception cases during form processing 

and which cases to review. If your scanner has a select stacker, you can also choose options on which to 

send the form to the select stacker. Once you make your selections, click the Save Data or Analysis links 

in the left task pane to continue. 
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Option Description 

Review Exceptions Mark this checkbox to activate the Review Exceptions feature during 

scanning. When selected exception cases are found, processing stops 

and you are required to take action (either correct the exception or 

continue the processing without correction). It is not common to stop 

the process to Review exceptions. The Review Exceptions process can 

also be launched after forms are processed. The following exceptions 

are available: 

 Multiple Responses 

 Blank Responses 

 Barcode Regions 

 Input Regions 

 Database Lookup Regions 

 Required items 

Reject Exceptions Mark this checkbox to use your scanner’s select stacker and reject 

forms with certain exception during scanning. When selected 

exception cases are found, the forms are sent to the select stacker. The 

following exceptions are available: 

 Multiple Responses 

 Blank Responses 

 Barcode Errors 

 Read Head Errors 

 Timing Mark Errors 

 Form Read Errors 

 Database Lookup Regions 

 Required items 

 Misordered Pages 

Review after processing forms Mark this checkbox to have Review Exceptions start after all of the 

forms are processed. Using Review Exceptions after processing forms 

means that the processing does not stop for any exceptions. Instead 

you use Review Exceptions post-processing to clean the data. 
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Automation Control Center - Save Data 

The Save Data Options window allows you to specify saving options while forms are being processed. As 

each page is processed, the data is written directly to the file specified (as opposed to saving after all 

forms are processed). This feature allows you to send data to an external file right as the forms are 

processed so that some other action can be taken on the data. Any changes made after processing the 

forms are not written to this file. Use of this saving option is not common. You typically want to use the 

Save Data options in the Open window of the Automation Control Center. Once you make your selections, 

click the Analysis link in the left task pane to continue. 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

Option Description 

Save Data  Mark this checkbox to save all data collected to one data file. Click 

the ellipsis (...) to select an existing data file or enter a new file name. 

If you choose an existing file, you are prompted to overwrite or 

append to the file each time. 
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Option Description 

Organize & Save The Organize & Save button allows you to further customize how 

data files are named and stored. In the file base name area, you 

may choose to add a region from the processed data to the file base 

name. Choose the region from the drop-down list and then click the 

Insert Data into file Name button. For example, if processing tests, 

you could add a Student Name field that is being collected from the 

form so that data file names all begin with the students' names. 

In the Destination folder area, you may choose to add a region 

from the processed data to the folder structure that will hold the 

data files. Choose the region from the drop-down list and then click 

the Append Data Onto Folder Path button. For example, if 

processing tests, you could add teacher name and student name 

fields that are being collected from the form so that each student's 

data is stored in a folder containing the teacher's name and then a 

subfolder containing the student's name. 

In the Table name area, you may choose to add a region from the 

processed data to the table base name if using a database or 

spreadsheet format. Choose the region from the drop-down list and 

then click the Insert Data into Table Name button. For example, if 

processing tests, you could add a Test Name field that is being 

collected from the form so that the table name contains the test 

name. 

Overwrite existing file or table Mark this checkbox to overwrite the selected data file each time the 

Automation Control Center file is executed. 
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Automation Control Center - Analysis 

The Automation Control Center can produce reports using Remark Quick Stats. You may run grade or 

survey operations, as well as save and export reports. Once you have configured your analysis options, 

you can save the RCEZ file. Please note that due to the changes made to saved answer keys and survey 

definitions in this version, you may need to recreate RCEZ files with updated versions of your files. 

 Note: To learn more about Remark Quick Stats in general, please see the Remark Quick Stats 

user’s guide installed with your software. 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

Option Description 

Analyze Data Mark this checkbox to run analysis on your data. 

Analysis type Choose Quick Grade, Quick Survey, Advanced Grade or 

Advanced Survey from the list to automatically launch this type 

of analysis. 

Load Report Preferences  Allows you to select a set of Remark Quick Stats preferences 

that you want to use for this operation. These preferences may 

be exported from a copy of Remark Quick Stats so that they 

may be used here. If your copy of Remark Quick Stats is already 

using the preferences you desire for this report, you may skip 

this option. 
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Option Description 

Save data  Mark this checkbox to save the Remark Quick Stats data as an 

RQS file for reuse within Remark Quick Stats. Then click the 

ellipsis (...) to choose a location in which to save the file. 

Export Excel reports Mark this checkbox to export the entire set of reports to the 

Excel format. 

Export gradebook Mark this checkbox to export the grade results to a gradebook 

file. Then click the ellipsis (...) to choose the gradebook type and 

a location in which to save the file. 

Export test item data Mark this checkbox to export the grade results to a test item 

data file. Then click the ellipsis (...) to choose the file type and a 

location in which to save the file. 

Export data & grade results Mark this checkbox to export the data and grade results to a file. 

Then click the ellipsis (...) to choose a file type and a location in 

which to save the file. If you wish to overwrite an existing file, 

mark the checkbox for Overwrite existing file or table. If you 

wish to save the numeric equivalents for the data set, mark the 

checkbox for Save numeric equivalent. If you wish to save the 

learning objectives in a row based file (each learning objective 

per student is a data record), mark the checkbox for Save row-

based learning objectives. 

Gradebook Options Click the Gradebook Options button to set parameters specific 

to the gradebook export you have chosen.  

Generate Report / Batch Click the ellipsis (...) to choose the individual report (.rpx) or 

report batch file (.rbwx) you wish to generate. Report batches 

are created in Remark Quick Stats using the Report Batch 

feature. This feature allows you to generate, print and/or export 

multiple reports without having to select each one individually. 

Note: If you select a report batch, the exporting and printing 

options are disabled, as these options are setup in the batch file. 

Export Report Click the ellipsis (...) to choose a file type and location to which 

to export the report for individual reports. 

Print Mark this checkbox to print the report once it is generated. 

Add/Delete Row Click the Add button to add another row where you may make 

further selections (e.g., run another report). Click the Delete 

Row button to remove the currently selected line of parameters. 
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